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1 Terms, abbreviations and references

Term

Quaternion

Euler Angles

Abbreviation
DOF
DSP
GNSS
GPS
QZSS
IMU
KML
KMZ
LLA
MFM
MT

MTB
MTM
OpenGL
SDK
SVinfo
UTC
WGS84

Xbus
XDA

XFF
XKF
XEE
XML

Description

A non-commutative extension of complex numbers. A unit length quaternion is a
convenient parameterization of rotations.

Representation of the spatial orientation of any frame of the space as a composition
of rotations from a reference frame.

Description

Degrees Of Freedom

Digital Signal Processor

Global Navigation Satellite Systems (GPS, GLONASS, Galileo, BeiDou, QZSS)
Global Positioning System

Quasi-Zenith Satellite System (Japanese Positioning System)
Inertial Measurement Unit

Keyhole Markup Language

Zipped Keyhole Markup Language

Latitude Longitude Altitude

Magnetic Field Mapping

Motion Tracker

MT Binary Communication Protocol

MT Manager

Open Graphics Library

Software Development Kit

Space Vehicle Information

Coordinated Universal Time

The latest revision of the World Geodetic System. It defines a reference frame for
the earth, for use in geodesy and navigation.

Xsens Communication Protocol

Xsens Device API, the communication APl between the MTi and the user
application. See also [MTi_10s_100s]

Xsens Firmware File format
Xsens Kalman Filter

Xsens Estimation Engine
eXtended Markup Language
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Reference id Document description

[LLCP] “‘MT Low-Level Communication Protocol Documentation.pdf’, document ID
MTO0101P

[MFM] “Magnetic Field Mapper Documentation.pdf’, document ID MT0202P

[FWU] “Firmware Updater User Manual.pdf’, document ID FUO100P

[MTi_10s_100s] | “MTi User Manual.pdf’, document ID MT0605P

[MTw_SDK] “MTw SDK User Manual.pdf’, document ID MV0319P

[MTi_1s] “MTi 1-series Data sheet”, document ID MT0512P

Note: The latest available documentation can be found in your MT Software Suite installation folder or
via the following link: https.//xsens.com/xsens-mti-documentation
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2 Xsens Help Center and User Community

Xsens has an extensive help center, a place where users of Xsens and Xsens employees (support, field
application engineers, sales and R&D engineers) meet. The knowledge base contains tips and tricks,
guidance and answers to frequently asked questions. News is also shared at the knowledge base and
it is possible to ask additional questions (registration required).

The user community is the place to ask questions. Answers may be given by other users or by Xsens
employees. The response time in the user community is significantly shorter than the response time at
Xsens support.

The knowledge base and user community are searchable simultaneously. A search query thus shows
results irrespective of the source.

Please visit https://base.xsens.com to complete your 1 minute registration.
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3 Introduction

This user manual describes the product features and operating instructions for Xsens’ MT Manager
2019.

MT Manager is compatible with all Xsens Motion Trackers (for a complete list of supported MTs, refer
to section 5.3). Note that listed features and sections in this document may not apply to all Xsens
devices. For device specific details please refer to the documentation listed in Section 1.

The MT Manager uses the XsensDeviceApi64.DLL or XsensDeviceApi32.DLL with the dynamic library
interface. This is the same API that is provided for software development in the MT SDK.

The MT Manager software is an easy-to-use software with familiar Windows user interface, which allows
you to:
e view 3D orientation in real-time
view inertial and magnetic sensor data in real time
view latitude, longitude, altitude plots in real time (depends on Motion Tracker used)
monitor and compose message to and from the device via a message terminal
export log files to other formats like ASCIl and KMZ
change and view various device settings and properties
run a self-test to check the mechanical functions of the inertial sensors and magnetometer

The MT Manager is therefore an easy way to get to know and to demonstrate the capabilities of the
Motion Tracker.
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4 Quick start

This section is intended to help you install and use the MT Manager quickly. For detailed instructions,
please go to sections 5 and 6.

4.1 Installing the MT Manager

First you need to install the MT Manager on your computer running Windows 7 or Linux (Windows 10
has been tested, but is not officially supported). This is easily done by using the MT Software Suite
application that guides you through the installation.

NOTE: the most recent version of the software, source code and documentation can be downloaded
from the support section of www.xsens.com.

For users of previous Xsens’ MT software:

Be sure to uninstall the previous version of the USB converter drivers:

Open the Windows Control Panel and go to Add or Remove Programs.

Look for the entry 'Windows Driver Package - Xsens USB-serial Converter Driver Package'. Please
uninstall all entries of these drivers.

For Windows Vista/Windows 7/Windows 8/Windows 10 users:

Download the installer from https://www.xsens.com/mt-software-suite/. This installation procedure also
tells the procedure to install the entire MT Software Suite.

The installation procedure installs several components and starts with the screen as shown below:

MT Software Suite ‘ MT Software Suite MT Software Suite
xsens 2019.0 xsans 2019.0 xsens 2019.0
Features Installation Folder MT Softwarne Suite has been successhully installed
Setup requires 493 MB in:
) " % u Select the features to be installed
“& Common files
“ T Manager
~ @& Magnetic Field Mapper

" . o th . vef 8 MFM SDK
‘ou must agree to the License terms and conditions before you o
can install MT Software Suite AT soK
[ agree to the License terms and conditions.

Figure 2: The installation procedure is straightforward. In the second screen, you can choose to skip
installation of several components (not recommended)

4.2 Connecting your device to MT Manager

Connect a device to your PC using the supplied USB cable. With the USB cable, the MTi device is
automatically found.
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4.21 Automatic COM port selection

Upon execution of the MT Manager it automatically scans the available COM-ports and/or MTi USB
devices on the PC for connected devices.

. Xsens MT Manager 2019

O X
Eile View Tools Window Help
BEEA® LR R, T AR DO @ 66 ® -
YEEEER= TR !
Device List

. Scanning for Hardware

‘Scanning ports...

- 10%

Figure 3: MT Manager scanning for attached devices
If you are using an RS-485 sensor, be sure to enable the RS-485 compatibility mode in the General

pane via “Tools” = “Options...”, refer to section 5.6. Without RS-485 compatibility enabled, the RS485
MTi device may not be found.

The MTis are displayed in the Device List with the respective unique MT device ID number.

. Xsens MT Manager 2019
File View Tools Window Help

ﬁ- E‘.ga‘ g\rzc;tm3 vHB::timte: v

Device List
v ‘ MTi-300 03782083 Measuring
¥ Device Information
Product Code MTi-300-2A8G4

Communication Port \\?\usb#vid_2639&pid_...
Firmware Revision  1.7.2 build 42 rev 64903
Hardware Revision  3.0.0
Location ID 0

Filter Settings profile general

Figure 4: The main screen of MT Manager with an MTi-300 attached via USB
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After physically connecting one or more devices, press the rescan button A

for connected devices on any available COM port and update the device list.
Q

When you want to disconnect all devices, press the disconnect button ** .

to let MT Manager search

4.2.2 Manual COM port selection
If you want to select the COM port manually, then in the Connectivity toolbar:

o = ¢y Port: Baudrate:
"@R CDM3 - || Auto -
Figure 5: The connectivity toolbar
You can choose a COM port and the baud rate if you are using a serial connection or a USB converter,

see below. Note that the direct USB connection does not have a COM-port. Instead, the USB has a
uniqgue USB name that you can find in the Device Settings dialog window, see section 6.2.2.4.

# Xsens MT Manager 2019

Eile View Tools Window Help

EES LR e,
y b Y

Figure 6: Manually selecting the COM port that MT Manager uses during its scanning procedure

& Xsens MT Manager 2019

File View Tools Window Help

o = Port: Baudrate:
£ e A ) B
i;ii ‘EEi L | észk % | COM 3 ~ || Auto g 7
. ) § - 2000000
SEDEF BEH [om K> @
460800
Device List
230400
~ & MTi-300 03782083
~ Device Information
Product Code MTi-300-2A8G4

Communication Port \\?\usb#vid_26398&pid_...
Firmware Revision  1.7.2 build 42 rev 64903
Hardware Revision 3.0.0
Location ID 0

Filter Settings profile general

Figure 7: Manually selecting the baud rate that MT Manager uses during its scanning procedure

For the COM ports you can choose between all active COM ports. It is recommended to use the “Auto”

I

baud rate to have the baud rate determined automatically. Then, press the “Scan Port” button®  *.

To learn how to retrieve the USB name, please refer to section 6.2.2.4.

"If you are using an RS-485 sensor, be sure to enable the “RS-485 compatibility mode” (refer to section 4.2.1).
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Now you are ready to go using your Motion Tracker with the MT Manager.

4.3 Basic functionality of MT Manager
This section describes how to setup the MTi for recording and exporting data.

4.3.1 Configuring Motion Tracker
After the MTi is connected, the MTi should be in the Device List in the bar on the left.

# Xsens MT Manager 2019
File View Tools Window Help

O = ¢ Port: Baudrate:
HER R Qow e -
PesiEl SHE R

Device List ®
~ & MTi-300 03782083 Measuring
~ Device Information
Product Code MTi-300-2A8G4

Communication Port \\?\usb#vid_2639&pid._...
Firmware Revision  1.7.2 build 42 rev 64903
Hardware Revision 3.0.0
Location ID 0

Filter Settings profile general

Figure 8: MT Manager showing the MTi-300 with DevicelD 03782083 in the Device List

The first step is to configure the MTi. Open the Device Settings window % . The Output Configuration
settings tab will be shown.

The default output configuration can be found in [LLCP]. The preset drop down bar allows choosing
other options. Recording data with the XDA processing preset allows reprocessing the file with any
compatible filter profile. It is possible to select individual data IDs, but note that when orientation is
selected, the onboard processed orientation is recorded. Files with onboard processed orientation data
cannot be reprocessed using a different filter profile.

# Device Settings for MT 03782083 ? x
Save Settings | | Write to Device
Deviceld 03782083 MT Settings Revision 5.1
Product Code MTi-300-2A8G4 Firmware Revision 1.7.2 Lozd Settngs Revert
LocationID 0 Selftest 000001FF
HardwarelD 2704C0A6 Test & Calibration Date 31-Oct-17

Hardware Revision 3.0

Qutput Configuration
Device Settings

Synchronization Options ® | Normal mode String report mode
Modeling Parameters
High-Rate Calibrated Outputs *
Timestamp +/  Pack| Onboard Processing

Figure 9: The Output Configuration windows features easy to use presets.
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In this step-through, the settings of the MTi other than the output configuration will not be changed. It is
however possible to change filter settings, configure synchronization options or to review the calibration
parameters. In the header, it also shows the hardware ID, Firmware Revision and other MTi information.

¥ Device Settings for MT 03782083 ? X
Save Settings | | Write to Device
Deviceld 03782083 MT Settings Revision 5.1
Product Code  MTi-300-2A8G4 Frmware Revison  1.7.2 Load Settings Revert
LocationID 0 Selftest 000001FF
HardwareID 2704C0A6 Test & Calibration Date 31-Oct-17

Hardware Revision 3.0

Figure 10: The header of the Device Settings window shows general information on the MTi

4.3.2 Recording data

First check if you receive data. Open for example the 3D view o and the inertial data graph ‘[; .

& Xsens MT Manager 2019 - [m] x
File View Tools Window Help
= INEy (w] @) Port: Baudrate: Orientation Reset Method: & =% Current Device ~
g;' i:| b 5{“\\ @ COM3  ~ | Auto = Inclination Reset M @ @J @ Gj ® ) Al Devices
- g ’ o [~ A
®élst F > @ By
el = 3D Orientation View for MT 03782083 O Inertial Data for MT 03782083 - 2K
» & MTi-300 2, 4 = 00| [ e - ER
Acceleration
v .Ach v AccY v .Accz
oI g WW% P L St
0 v
45 45 34.745 35745 36.745 45 45 39.745. 40,745
Time
Angular velocity
v .Ang velX v Ang vel Y v .Ang velZ
s i a |
B By LI T " e/jv“ i
2,745 33,745 34,745 35,745 f36‘745 745 38,745 39745 40,745
Time
Magnetic field
v .Mag X v Mag Y v .Mag z v .Mag Norm
0.5
B
=B anly P
uk %60 “aa260" TA760 3760 36760 31760~ HTTE0 T IS0 A0TED
7 S Time
Figure 11: A typical view of MT Manager
. Record
Press the record button in the menu bar: .
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The record status is shown in the bottom right corner: REC]]
Press the record button again to stop recording.

4.3.3 Opening the file and playback data

Open the file with File — Open,CTRL+O or the Open File icon . When orientation data is not in the
file, a pop-up window will ask for the required filter profile. When applicable, additional processing
options can be enabled or disabled by using the check boxes. See [MTi_10s_100s] for more
information on filter profiles and additional processing options.

¥ Select Processing Options ? X

No orientation data present in the file.

Please select MT Manager Fitter Processing options.

Fitter profile: 39.16 general -
Active Heading Stabilization (AHS): Enable AHS
In-Run Compass Calibration (ICC): Enable ICC

OK Cancel

You Figure 12: After opening a file with MT Manager, a window is shown when orientation is not
can available in the file.
now

playback the file by pressing the Play-button. You can revert to the beginning of the file with the Rewind
to Start-button.

Ka > @
Figure 13: The Playback toolbar

Choose to playback data in real-time or at once by changing graph settings in Tools - Preferences.

Table 1: Playback and plotting options

Parameter Comments

File plotting Real-time plays data in real-time;
All Data (as fast as possible) plots all data at once. Note that you need to increase
the Maximum Display time to see all data;

All Data (update every 5 sec..) is required when the file is extremely large

Maximum display time | Increase this value to a higher value (File) in order to show more data, especially
useful when investigating a file.
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& preferences ? X

¥ MT Manager

Orentation Flots

Miscellaneous

XDA Options ® | Euler Angles
¥ Logging

General Quaternion

Temperature Plots

@ Celsius

Fahrenheit

Display Graphs as Strobes

File Plotting

Real-Time
Al Data (update every 5 seconds until all data is processed)

® Al Data (as fast as possible)

Time Options
Minimum Display Time

Live | 500 ms = Default

Fie |10 ms Default
Maximum Display Time

Live | 10000 ms - Default

Fle | 161000 ms : Default W/ Auto Adjust

OK Cancel
Figure 14: The Graphs options in the Tools - Preferences window

4.3.4 Exporting a file to ASCII
In order to use the data in other programs, e.g. Excel or MATLAB, the MT Manager allows to export the

data to a text file. To do so, click open a log file and press the Export button @* . A window will open in
which you can elect the data to be exported. When the exported data is not available, the field will be
filled with the Empty Field option. Click Export to generate the ASCII text file.
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# Export Open File ? X

Please configure your export:

Output path @\

Flename MT_03782083-003-000.txt

Exporter ASCII Exporter (*.txt) -
Filter Profile  XDA: 39.16 general Manage
File Name
Output Filename:  <inputfie=-<seqnr> . txt
Output Frame Delimiter Options Empty Field Options
Coordinate Systen |ENU Comma - NaN -
Exported Data
Orientation Position and Velocity GNSS Status
Quaternion Position GNSS Receiver Message Status Word
«/  Euler Angles Velocity Clipping Flags
Matrix RSSI
Inertial Data Miscelaneous Sensors Timestamp
Orientation Increment +/ | Magnetic Field +/ | Packet Counter
Velodty Increment Temperature Sample Time Fine
« Rate Of Turn Gyro Temperatures Date and time
Rate Of Turn (HR) Barometric Pressure UTC Time
W/ Acceleration

Acceleration (HR)

Free Acceleration

| Export Cancel

Figure 15: The Preferences — ASCIl Exporter window
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5 Overview MT Manager

This section describes the options available to the user in the MT Manager.
In section 6 operating the MT Manager is described.

5.1 Purpose

The purpose of the MT Manager is to provide easy access to the capabilities of any of the currently
supported devices (refer to section 5.3).

The MT Manager can be used to interface with the MT and to visualize and log data. It offers export
options for ASCII text files. The ASCII export format can be customised to your needs.

5.2 MT Manager features

The MT Manager software is an easy-to-use software with a familiar Windows user interface, which
allows you to:
e view 3D orientation in real-time
view inertial and magnetic sensor data in real time
view latitude, longitude, altitude plots in real time (depends on Motion Tracker used)
view and compose messages to and from the device via a real time message terminal
reprocess binary data log files
export log files to ASCII
change and view various device settings and properties
run a self test to check the mechanical functions of the inertial sensors and magnetometer

The MT Manager is therefore an easy way to get to know and to demonstrate the capabilities of your
Xsens Motion Tracker.

5.3 Supported devices
Currently the following devices are being supported by the MT Manager:
e MTi 1-series
e MTi 10-series 4" and 5" generation
e MTi 100-series, including MTi-G-710 GNSS/INS 4t and 5" generation
e MTw Awinda [MTw_SDK])

For detailed information about these MTs, please refer to the corresponding User Manuals and

Technical Documentation: [MTi_1s] and [MTi_10s_100s].
Future Xsens Motion Trackers will be supported as of their release.

5.4 Input Options

The MT Manager can handle real-time input and input from recorded binary files (see also sections 6.4.1
and 6.4.2).

Real-time: Serial data using USB or COM port (via USB virtual COM-port or RS2322).

Files: .MTB (MT Binary Communication Protocol)? log files. Contain recorded output log-files
from a Motion Tracker.

In both cases the input (file) format is the same.

2 COM1 and COM2 only
3 The .MTB extension is associated with MT Manager.
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The .MTB log files generated with the MT Manager will contain the following MT Data messages:
Configuration data

Extended MT Specification data (eMTS)

Filter state message, message ID 0x98 (in case of data with preset “XDA processing”)

If enabled, UTC date and time at regular intervals (as configured)

If enabled, GNSS satellite SVInfo at regular intervals (as configured)

MTData2 at output frequency (as configured)

The MT Manager software handles the request of these additional data packets from the MT (not only
requesting MT Data) to enable full analysis of log-files in the MT Manager software later.

NOTE: An MTB file can contain any number of MTData2 packets that are requested from the MT. Only
if an MTB file contains Sensor Component Readout or sensors data (Ag/Av or inertial data) and/or GNSS
data messages, the data can be re-processed using different filter profiles. In all other cases the .MTB
file is considered a log-file, which can be played back again for viewing.

In the case that only sensors data and/or GNSS data is requested from the MTi, the MT Manager will
run the sensor fusion filter in XsensDeviceApi64.DLL of the host PC (and not on the DSP of the MT) to
estimate orientation, position, velocity.

5.5 Output Files

The MT Manager can export data logged in .MTB files to different formats as described in section 6.4.3.

ASCII text data
e Calibrated sensor data (3D acceleration, rate of turn, magnetic field, Ag/Av, free acceleration,

etc.)
e Orientation data
e Position
e Velocity

The output orientation can be represented in different conventions:
e Unit normalised Quaternions (also known as Euler parameters)
e Euler angles: roll, pitch, yaw (XYZ Earth fixed type, also known as Cardan)
¢ Rotation Matrix (Direction Cosine Matrix)

Data and (UTC) time can also be included in the exported files. See 6.4.3.5 for more information on the
columns of the exported ASCII file.

KMZ geographic data
e Timestamp
Position
Velocity
Orientation
GNSS Mode
UTC time

KMZ files (available from MTi-G-710 and MTi-7data sets only) are excellent to study trajectories in e.g.
Google Earth.

5.6 Menu bar
In the MT Manager menu bar you will find the following entries:
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# Xsens MT Manager 2019

File View Tools

Window Help

Figure 16: The menu bar in MT Manager

In the table below each (sub-) entry is explained.

Entry
(level 1)

File

View

Tools

Entry (level 2)

Open File

Close

Export

List of last opened files
Exit
Displays

Status bar

Preferences

Table 2: The MT Manager menu structure

Entry (level 3)

Device List
Message Window
Device Settings
3D Orientation
Inertial Data
Orientation data
Status Data
Temperature Data
Velocity

Altitude

Device Data View
XDA Data View

Position
Space Vehicle Information
UTC Date/Time

MT Manager

19

Description

Open a previously recorded (shortcut: CTRL-O):
e  MT Manager log file (.mtb)
e Xsenslogfile (.pin and .xm)
e  Xbus Master log file (. xm)
e Binary log file (.bin)

Closes the currently opened file

Export an opened log file to (shortcut: CTRL-E):
. ASCII formatted file
For more details, refer to section 6.4.3.

A list of last opened files

Closes MT Manager

Toggle to open/close Device list. Refer to section 5.7.1
Toggle to open/close the Messages window
Toggle to open/close the MT Settings dialog
Toggle to open/close the 3D display of orientation
Toggle to open/close the inertial data graph
Toggle to open/close the orientation graph
Toggle to open/close the status graph

Toggle to open/close the temperature graph
Toggle to open/close the velocity graph

Toggle to open/close the altitude graph

Toggle to open/close the Device Data terminal

Toggle to open/close the XDA Data terminal (hidden by
default, enable this feature through Tools>Preferences)

Toggle to open/close the position graph
Toggle to open/close the SV information graph
Toggle to open/close the UTC date/time window

Toggle to switch on/off the status bar at the bottom of the
MT Manager window. This status bar shows playback
information, “extended” tool tips etc.

Here you can change the following general settings:
Graphs:
- Euler Angles or Quaternions
- Celsius or Fahrenheit
- Toggle display graphs as strobes
- File Plotting mode: Real time or All data
- Display time in graphs
Miscellaneous:
- Orientation output frame
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Window

Help

Restore
Communication

Wireless configuration

Power off

Tile

Cascade
Documentation

Support

Updates

Online Shop

About MT Manager

Logging

All Docked MTws
Wireless system

All Devices

BASE - Knowledge Base
and Community Forum

Contact Support

Download Firmware

Updater

Check for new MT Software
Suite versions

5.7 Data views, toolbars and buttons
In this section the sub-windows, toolbars and button functionalities of the MT Manager are explained:

5.7.1

The Device List

- Toggle show docked MTw's and log and
visualize docked MTw’s
- Enable RS485 Compatibility
- Enable XDA Data View
XDA options:
- Allows to load an alternative filter profiles file
(use by Xsens support department only)

Here you can change Logging Settings (refer to section
6.4.1)
- Name of the log file (template)

Resets the communication settings of an MTi to the
default factory settings, allowing to regain communication
with an MTi in MT Manager (COM port interface only)

Opens the wireless configuration window (MTw only)
Powers off all docked and USB connected MTws
Powers off all MTws that have a wireless connection
Powers off all MTws

Tiles the open graph windows. Tiling will be done in order
of opening. With 3 graphs, opening the graphs in a
specific order determines which graph is over the entire
height of the window in the left column and which graphs
are placed as smaller windows in the right column.

Cascades the open graph windows
Links to the latest online documentation

Links to BASE - Articles, guides, FAQ and online user
forum

Contact Xsens Product Specialists

Links to the download page for the MTi Firmware Updater
Check for new MT Software Suite versions

Opens the webpage http://shop.xsens.com where
accessories and MT’s can be ordered.

Display version information and includes EULA

By default, the Device List is displayed in a sub-window, showing useful information about your MT.
Note that the Device List is read only.

20
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Device List
~ & MTi-300 03782083 Measuring
~ Device Information
Product Code MTi-300-2A8G4

Communication Port \\?\usb#vid_2639&pid_...
Firmware Revision  1.7.2 build 42 rev 64903
Hardware Revision 3.0.0
Location ID 0

Filter Settings profile general

Figure 17: The Device List

The information in Table 3 is available.

Parameter

DevicelD

Product Code

Location ID

Serial Port
Filter Settings Profile

MT System State
Measuring
Recording
Flushing

Config Mode

File Mode (open)

File Mode (loading)

File Mode (ready)

File Mode (playing)

Table 3: The data shown in the Device List

Description

A unique DevicelD. See [MTi_10s_100s] for
explanation of the DevicelD

Product code, built up from type of device,
product series, interface, accelerometer range
and gyroscope range.

Location ID that allows identifying the MTiin a
system setup

USB or COM port number

The filter setting profile used for orientation

Comments

Fixed value, retrieved from
device

Fixed value, retrieved from
device

Can be set in MT Settings
Dialog

Automatically detected

Can be set in MT Settings
dialog

Table 4: The MT System State shown in the Device List

Description
The MT is outputting data
Data is being saved to file

Data is being retransmitted after recording
has been stopped

MT is in config mode. This happens when
configuration messages are sent to the MT
or when the user puts the MT in config mode

A file is selected. MT Manager is waiting for
the user to process the file.

A file is being loaded and processed
Displayed when afile is loaded and when the

entire file has been processed.

Displayed when the file is being played back

21

Comments

Applies to Awinda MTw only

When you close MT Manager,
the MTi will go to Config
Mode. See
https://base.xsens.com/hc/en-
us/articles/115003997494

Progress is displayed in the
fourth column.
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With the Device List, it is possible to disconnect specific devices. Right-click on any parameter
associated with the MTi that needs to be disconnected, right click and choose Disconnect. The MTi will
be removed from the Device List.

Device List 5]
- & MTi-300 03782083 Measuring
~ Device Information
Product Code MTi-300-2A8G4

Communication Port \\?\usbh#vid 26208mni
Firmware Revision  1.7.2 buildm
Hardware Revision  3.0.0
Location ID 0
Filter Settings profile general

Figure 18: Right-click on the Device allows to disconnect a single MT

% 5.7.2 Device Settings

In the Device Settings window several (low-level) settings can be changed, including the output
configuration. Take caution in changing settings in Device Settings as these settings can have large
effects on the MTi device. In this window it is possible to save and load a set of device-specific settings,
including the output configuration that can be copied to other devices (with the same product code). You
can always revert a device to its Factory Settings using the Revert button.

For details on the Device Settings, please refer to Section6.2.2.

5.7.21 Output configuration

In the Output Configuration tab, all output options of the MTi can be set, including frequencies and
formats.

Output Configuration
Device Settings

. N L)
Synchronization Options Normal mode String report mode
Modeling Parameters
Preset: | XDA Processing - Link Formats Link Fregs
Timestamp «/ Packet Counter v/ sample Time Fine Sample Time Coarse
UTC Time
Orientation No Orientation - Floating Point 32-bit 400 Hz
Inertial Data v g Rate of Turn Floating Point 32-bit v | 400 Hz v
v av Acceleration Free Acceleration
Magnetic Field +/  Magnetic Field Fioating Point 32-bit v | | 100 Hz v
Temperature Temperature Floating Point 32-bit 400 Hz
Pressure v/ Barometric Pressure Floating Point 32-bit ~ | |50Hz -
High-Rate Data Acceleration HR Rate of Turn HR 1000 Hz
Status J Status Word Status Byte
Position and Velocity Latitude and Longitude | No Aftitude - Fixed Point 16.32 400 Hz
Velocity GPS Age
GNSS Data v/ PvtData Satinfo 4 Hz '

Figure 19: the Output Configuration tab for an MTi-G-710 GNSS/INS. Depending on the MTi attached, the
Output Configuration window may show fewer options.

5.7.3 Data Views

The MT Manager offers a wide range of information displayed in its sub-windows, which can be opened
and closed via the (Main Views and GNSS) toolbar buttons or the menu bar:
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Figure 20: The Data Views and GNSS toolbars
The
individual buttons and their functionality will be explained in the next sub-sections; availability of some
of the buttons and related sub-windows depends on the type of the connected device (e.g. position and
velocity information will not be accessible with e.g. MTi-20 VRU or MTi-300 AHRS).

The icons corresponding with the button that activates a specific sub-window are displayed on the top
left of each subsection.

5.7.3.1 @ 3D Box view

The 3D Box View is a real-time graphical (OpenGL) representation of the MT orientation measurements,
i.e. roll, pitch and yaw.

4.5
Figure 21: The 3D Box view is an easy way of visualizing the orientation of any MTi

=~

5.7.3.2 @ |nertial data view

Per sensor type, the Inertial Data view graphically shows the 3D calibrated measurement data vs. time:
e acceleration (from the accelerometers) in m/s?;
e angular velocity (from the gyroscopes) in deg/s;
e magnetic field (from the magnetometers) in normalised arbitrary units (a.u.).
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Figure 22: The Inertial data view for acceleration, angular velocity and magnetic field

Table 5 explains the line colours and the buttons in this view.

Table 5: The line colours in the inertial data graph

Colour @ Corresponding axis

Red Acceleration, angular velocity (roll) and normalised magnetic field in X direction
Green | Acceleration, angular velocity (pitch) and normalised magnetic field in Y direction
Blue Acceleration, angular velocity (yaw) and normalised magnetic field in Z direction

Black Total acceleration, angular velocity or magnetic field, if available

Automatic scaling
It is possible to choose the scaling of the inertial data plot using the pull-down dialog.

|]<]<] D ™  no auto scaling *

expand to fit
Alb|Ee | B o ="

Figure 23: Tools let you configure the graphs

Table 6: The different scaling options in the graph windows.

Scaling option Functionality

No auto scaling Y-scale will no longer be scaled

Expand to fit Y-scale will be stretched to show all data in plot
Full fit Y-scale will be stretched to show all data in plot
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Zooming

When the Zoom-icon is selected, you have several options to zoom.

Option 1: Press and hold either mouse button, drag mouse to make a zoom rectangle (right button
zooms out, left button zooms in):

Euler Orientation Data for MT 07700054 [E=R[E=R =<

B+ B Ene
V] [l rol | [l itch ¥ Il raw

160

20:148;112:6

-80

7
-160

14.775 15.775 16.775 17.775 18.775 19.77 20.775 21775 22775 23.775
Time

Figure 24: A zoom rectangle in the Euler angles graph

23.895,57.

-Release mouse button to zoom in/out to the zoom rectangle
-Press other mouse button to cancel the zoom
-Use scroll wheel to make minor adjustment to first point of the rectangle

Option 2: Double click and hold one of the mouse buttons to generate a default zoom rectangle
centered around the mouse position with zoom factor 2.0 (right button zooms out, left button zooms
in):
Then:

-Release mouse button to zoom in/out to the zoom rectangle

-Press other mouse button to cancel the zoom

-Move the mouse to move the zoom rectangle

-Use the scroll wheel to increase/decrease the zoom factor

Option 3: Use scroll wheel without buttons pressed to simulate a double click centered around the
mouse position and immediately applying the zoom i.e. apply a default zoom rectangle centered
around the mouse position (right button zooms out, left button zooms in).

- NOTE: Zooming is not possible when the autoscale method is set to “full fit”.

Zooming in y-direction only
When zooming with the above option, it can happen that new data will not be shown in the zoom box,
as the x-scale (time) ends before the place where new data is created. In order to zoom only in y-

direction, enable the function “show all samples” with the show all samples button:

When “show all samples” is enabled, the x dimension of the zoom rectangle is always the complete
width of the graph:
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Figure 25: Zooming in y-direction only can be enabled with the button "show all samples”

Panning the graph

When the pan icon is enabled, you can pan the graph with the following actions:
- Press and hold left/right mouse button

- Release the mouse to stop panning

- Move the mouse to pan the graph

NOTE: Panning is not allowed when the autoscale method is full fit

Euler Orientation Data for MT 07700054
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Figure 26: Panning is available in all directions

Showing data values

With the Show Values button enabled, hovering over the graph will display the values at that
moment.
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Figure 27: The Show Values button activates the possibility to see the values in the graph

Showing less data channels

With the checkboxes, it is possible to omit data from the plot. This way, you can closely investigate
one particular signal.

.Accx D.Ach D.Accz

mys2

Freezing a graph
When you are using an MTi in live view, you cannot pause the file (see section 5.7.6), to investigate

data further. In that case, you can use the freeze button and zoom and pan on visible data:

Clearing and resetting graphs

There are two ways of clearing and resetting graphs. To clear the graph, use the clear button k .

Another way to reset the zoom that is very convenient when you have used zoom and pan functions,
is to close and open the graph.

5.7.3.3 Orientation data view

The Orientation data view shows the 3D orientation (calculated from the angular velocities) in either
Euler angles in degrees vs. time or Quaternions vs. time
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Figure 29: The orientation graph shows the orientation of the MTi over a period of 10 seconds

Table 7 explains the line colours in “degrees vs. time” view:

Table 7: Colours in the Euler angles graph

Colour | Corresponding axis
Red Orientation of the X-axis
Green | Orientation of the Y-axis

Blue Orientation of the Z-axis
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Figure 30: The quaternion graph shows the 4 components in one graph

Table 8 explains the line colours in the “Quaternions vs. time” view:

Table 8: Colours in the quaternion graph

Colour | Description

Red q1
Green | g2
Blue q3
Black q0

Please refer section 5.7.3.2 for explanation of the various buttons and checkboxes.

5.7.34 E MT Status
The MT Status sub-window displays various status flags.

Be sure to enable the Status Data Output in MT Output Configuration dialog:

Status | status Word Status Byte

Figure 31: Tick boxes for status in the Output Configuration window
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Figure 32: The status window of an MTi-30 AHRS. In this particular screen shot, several gyroscopes are
clipping

Signal Level
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Figure 33: The status windows of the MTi-G-710 and MTi-7 have two extra channels, GNSS Fix and Filter
Mode

Signal Level

Please refer section 5.7.3.2 for explanation of the various buttons and checkboxes.
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Colour
Red

Light green
Dark purple

Bright blue
Orange

Dark blue (3x)
Dark green (3x)
Dark red (3x)
Magenta

Table 9: Signals in the Status window

Status data description

Motion Tracker has passed the self-test according to eMTS. For an up-to-date self-
test indicator, see [LLCP], RunSelfTest

Filter accuracy indicator; low="not accurate”, high="accurate”

Manual Gyro Bias Estimation (refer to https://base.xsens.com/hc/en-
us/articles/360002763354):

1 (high): running with no rotation assumption
at ?/3 of the y-axis: error: rotation detected, no gyro bias estimated
0 (low): estimation complete, no errors

GNSS fix; indicates if the GNSS receiver has a valid fix

RepMo: Representative Motion mode of In-run Compass Calibration (ICC) active
Clipping flags for the accelerometers, 20g

Clipping flags for the gyroscopes, 450 deg/s or 1000 deg/s

Clipping flags for the magnetometers

Filter mode; indicates what the state of the filter in the MTi-G-710 or MTi-7 is, see
[LLCP]

5.7.3.5 B Temperature view

The Temperature view window shows the internal temperature of the device. Temperature data is
visualized in degrees Celsius by default. In order to change to degrees Fahrenheit, go to Tools >
Preferences > MT Manager > Graphs.

2 ¢ =% 01| & no auto scaing | ££ &I
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Time

Figure 34: The Temperature view window, showing that the MTi is warming up directly after powering it.
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5.7.3.6 @ Velocity view

The Velocity view window visualizes the 3D velocity of the MTi (MTi-G-710 and MTi-7 only). By default,
Velocity is visualized in the East-North-Up (ENU) format. In order to switch between ENU, NWU and
NED visualizations, go to Tools > Preferences > MT Manager > Graphs.
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Figure 35: The Velocity data view, displaying 3D velocity in m/s

Velocity {m/s)

5.7.3.7 ﬂ Altitude view

The Altitude view window visualizes the altitude of the MTi (MTi-G-710 and MTi-7 only). Altitude is
displayed as height above the WGS-84 Ellipsoid in meters.

v . Altitude
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Figure 36: The Altitude data view, displaying height above the WGS-84 Ellipsoid in meters
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5.7.3.8 D Position view

The Position view window visualizes the 2D position of the MTi (MTi-G-710 and MTi-7 only). Position is
displayed in terms of longitudinal and latitudinal coordinates.
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Figure 37: The Position view, displaying 2D position

5.7.3.9 ﬁ Space Vehicle Information window
The Space Vehicle Information (or Satinfo) Window shows the various satellites with their respective

signal strength in dBHz.

The columns are labelled according to the constellation and the number of the space vehicle. The digit
in front of the semicolon indicates the satellite system, the number after the semicolon is the satellite
number. E.g. 0:5 indicates Space Vehicle #5 from the GPS constellation. The labels are

Label

Detected (unused)

Used

Used+D

Unhealthy

Color

Blue

Dark green

Light green

Red

Table 10: Colours used in the SV information window

Meaning

The satellite data is not used for the navigation solution.
Note that SBAS satellites (1:#) can only be detected or
unhealthy. If SBAS corrections are being used for the
GPS satellites, the GPS satellites are light green.

The satellite data is used for the navigation solution. No
differential corrections have been applied.

The satellite data is used for the navigation solution;
differential correction have been applied. GLONASS
satellites do not have differential corrections, so they are
always dark green if used for the navigation solution

The satellite data is not used
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Figure 38 The SV info window showing 5 GPS satellites and 6 GLONASS satellites being used for the
navigation solution and 2 satellites that have been detected.

Signal Strength (dbHz)

5.7.3.10 UTC Time view

The UTC Time view window visualizes the UTC Time output of the MTi. The GNSS receiver
automatically retrieves UTC Time for the MTi-G-710 and MTi-7. For all other devices, UTC Time can be

set manually (see 6.2.2.4).
(1-113- 11
[ CUD D By I

A e 1
G | I N R NN

Figure 39: The UTC Time view.

5.7.3.11 @ 'xoa Device/XDA Data View terminals

The message terminal shows messages sent to and received from the device or the Xsens Device API
(XDA) in real-time. The Device Data View terminal can also be used to compose low-level messages in
order to quickly understand the communication protocol. See section 6.3 for more information about the
message terminals. The XDA Data View is hidden by default. It can be enabled through
Tools>Preferences.
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Figure 40: The message terminals for the device (left) and XDA (right)

5.7.3.12 Message window

The message window shows warnings and other informational messages.

Messages x

12.12.2012 - 09:16:00.485 —-> WARNING: Device: 0360005A missed 3 packets
12.12.2012 - 09:16:00.485 —-> WARNING: Device: 0360005A: A packet counter value was missed.

Figure 41: The messages window may show warnings on e.g. missed data packets

5.7.4 Connectivity
With the Connectivity toolbar you can control connecting your devices:

o = Port: Baudrate:
*® ﬂ COM3 ~ |Auto -

Figure 42: The Connectivity toolbar

Please refer to section 4.2 for details on how to connect and disconnect your devices.

5.7.5 File control
The file control tool bar makes it possible to choose where files are stored and opened.

—»  Current Directory:

=
— == | C:\MTM logs - @

Figure 43: The File control toolbar
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Table 11: Meaning of buttons in the File Control toolbar

Icon | Action

Open a previously recorded file (see also “File > Open...”)

=2 Export an opened log file (see also “File > Export...”)

Set the Current Directory (by browsing)

5.7.6 Playback & recording
To be able to record data and playback recorded data, the MT Manager offers the Playback & Recording

toolbar.

<P @ KKP @

Figure 44: The Playback and recording bar when an MTi is attached (left) and when a file is loaded in MT

Manager (right)

Table 12: Meaning of the buttons in the Playback and Recording toolbar

Button name Button
icon

Record/

Stop Record Q
Play l>
Rewind ﬂd‘q

5.7.7 Orientation resets

Functionality

Pressing this button will turn on the logging of data to a file (see also
section 6.4.1)

Releasing this button in recording mode, will turn off the logging

Pressing this button will start (or continue) playback of logged data (see
also section 6.4.2)

During playback, pressing this button will go to the start of the logging

Please refer to [MTi_10s_100s] for detailed information about orientation resets and the effects these
have. Available resets are summarized in Table 13. Note: be cautious to use the orientation resets.

Reset type

Heading reset

Inclination
reset

Alignment reset

Table 13: The available orientation resets

Functionality

redefines North to the x-axis of the device — applies to
RotLocal

redefines device coordinates system such that momentary
inclination is zero — Applies to RotSensor

combines the heading reset and the object reset — applies
to both RotLocal and RotSensor
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After choosing the reset type, press the Reset Orientation button @

You can also choose to apply the reset on the current device or on all connected devices.
After a reset you can store the new values to the MT Settings by pressing the Store Orientation button

@

Heading Reset
Inclination Reset @ @

Alignment Reset

!

Default Heading
Default Inclination

Default Alignment

Figure 45: The orientation resets toolbar can be used to apply a specific reference coordinate system to
the MTi's orientation, velocity and sensors data output

5.7.8 In-run Compass Calibration & Representative Motion

In-run Compass Calibration is a way to calibrate for magnetic distortions present in the sensor operation
environment using an onboard algorithm leaving out the need for a host processor like a PC. It estimates
the hard- and soft-iron effects and provides new magnetometer calibration parameters. To expedite the
calibration of the magnetometer sensor readings with respect to the new field, there is a feature called
Representative Motion. Click the button Start/Stop Representative Motion and rotate the device together
with the object that disturbs the magnetic field in all directions of the actual application.

Z

Figure 46: Click the Representative Motion button to start the Representative Motion mode. Click it again
to stop the Representative Motion mode.

If you want to store the new values in the non-volatile memory (remember that they are discarded when
you power cycle the MTi), press the store button:

¢

Figure 47: This button stores the ICC parameters in the non-volatile memory

For more information on ICC and Representative Motion, refer to the following link on BASE:
https://base.xsens.com/hc/en-us/articles/213588029
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5.7.9 Manual Gyro Bias Estimation

Manual Gyro Bias Estimation is a way to quickly estimate the gyroscope zero-rate offsets or biases.
This feature can be particularly useful when trying to reduce Heading drift with VRU devices or slowly
moving GNSS/INS devices. Manual gyro bias estimation forces the filters of the MTi to estimate the
gyroscope biases by assuming that the MTi will be held motionless for a given period of time.

In order to perform a manual gyro bias estimation using MT Manager, click the corresponding icon,
. A window will open, providing guidelines to the user. For more information on this feature, refer to
BASE: https://base.xsens.com/hc/en-us/articles/360002763354.

. Manual Gyro Bias Estimation ? X

Perform estimation for all connected devices

- Please refer to BASE for more information on this procedure
- Select estimation time

- Press "Estimate now"

- Keep the sensor stil (no rotation) for the estimation time

ESOS I S

Duration: 10 2 | seconds Estimate now Close

Figure 48: The Manual Gyro Bias Estimation window guides the user through the use of the feature.
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6 Operating guidelines

6.1 Overview

This section describes the configuration and typical utilisations for managing your devices with the MT
Manager.

6.2 Configuring the MT Manager and your devices

6.2.1 General settings

Changing the settings of your devices can be done (dependent on the setting) in:
1. Device Settings sub-window (refer to section 5.7.2).
2. Message terminals (refer to section 6.3). Be cautious when changing settings here, as you can
send any message to the MTi, even if the specific MTi does not support the message.

Note: changing the settings in the Device Settings window requires the user to explicitly invoke writing
to the MT:

Press the “Write to MT” button, to actually save your changes to non-volatile memory in the MT device.
MT Manager will then write the settings to the device and rescan for devices:

? X

Save Settings | | Write to Device

Load Settings Revert

Figure 49: In the Device Settings window, it is important to write the changes made to the MTi

6.2.2 Using the Device Settings window

The Device Settings window %Iets you modify all non-data output related settings, such as
communication and filter settings.

6.2.2.1 Header

® Device Settings for MT 03782083 ? X
Save Settings | | Write to Device
Deviceld 03782083 MT Settings Revision 5.1
Product Code MTi-300-2A8G4 Firmware Revision 1.7.2 fcadsatings Revert
LocationID 0 Selftest 000001FF
HardwarelD 2704C0A6 Test & Calibration Date 31-Oct-17

Hardware Revision 3.0

Figure 50: The header shows general information on the MTi

In the header, you will find the following parameters (all read-only, except for LocationID).
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Table 14: Explanation of the information in the header of the Device Settings window

Parameter Description

DevicelD 8-digit unique DevicelD of MTi (hexadecimal), refer to [MTi_10s_100s] for
details on the format

Product Code The product code of the connected MTi or file, refer to [MTi_10s_100s] for

details on the format

LocationID Can be used to identify Motion Tracker by a number (0-255) instead of its
Device ID. This can be particularly useful when a fixed setup with multiple
interchangeable MT’s is used

HardwarelD HardwarelD indicates the hardware DevicelD. This ID is assigned during
assembly
Hardware Revision Hardware revision of the MTi

MT Settings revision The extended Motion Tracker Settings layout
Firmware Revision Firmware revision of the currently connected MTi.

Self test When all sensors passed the Built-in Selftest (BIT), this shows 00001FF.
This field is only visible for MTis supporting the self test functionality

Test & Calibration | Shows when the device was tested and calibrated at Xsens
Date

6.2.2.2 MTi configuration file

With the MT Manager it is possible to save and load predefined set of settings, such as synchronization
settings, output configuration and baud rate. These settings can be copied from a device into a dedicated
file. The file can then be loaded and the same settings can be applied to another MTi with the same
product code, e.g. MTi-30. This feature is useful for system integrators that need to configure many
MTi’s. Note that this feature is only available with devices with a firmware version of 1.2.3 or higher.

The following settings are saved (message ID between square brackets):

RotSensor and RotLocal [0xEC]

Baudrate [0x18]

Filter profile (if available, otherwise the filter profile in the device will be used) [0x64]
Extended Output Mode [0x86]

Position (Latitude, Longitude, Altitude) [OX6E]
Location ID [0x84]

OptionFlags (see [LLCP] for full contents) [0x48]
OutputConfiguration [0xCO]

OutputMode (legacy) [0xDO0]

10. OutputSkipFactor (legacy) [0xD4]

11. Period (legacy) [0x04]

12. SyncSettings [0x2C]

13. GnssPlatform [0x76]

CoNOO~WN =

To save a setting, click the “Save Settings” button in the MT Settings dialog.

A pop-up screen opens that allows you to save the settings in a name that you prefer. As the settings
are product dependent, you could include the name of the product in your file name, e.g.”Test1_MTi-
30.xsa”.
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To load a settings file, click the “Load settings” button. Again, a window opens that lets you navigate to
an xsa configuration file. Opening the file applies all the settings to the MTi in the order listed above.
When no or only some settings cannot be applied, a warning will be issued. Settings that could be
applied up until the incompatible setting will be applied though.

Although the configuration file can be read, it is not recommended to make changes in the file. It is

easier to load the settings in the device, make the required changes and save the settings again (in the
same file).

6.2.2.3 Modeling parameters

In the modeling parameters tab you can find the calibration parameters of the accelerometers,
gyroscopes and magnetometers (offset, gain and misalignment, refer to [MTi_10s_100s] for details).

Output Configuration

A 3 Accelerometers Rate Gyros
Device Settings
Synchronization Options Offset 32742.8 32766.1 32860.9 32706.7 32874 32884.8
Modeling Parameters )
Gain 147.704 147.083 150.828 3084.71 3121.65 3147.27
Misalignment 0.999974 0.00527588 -0.004590817 0.999951 0.00208349 -0.0117727
-0.00612587 0.99997 0.00472406 -0.00616339 1 -0.00045606
0.00515799 -0.00476225 0.999976 0.00158788 -0.00311918 1.00002
Magnetometers
Offset 33818.9 32766.7 33313
Gain 2142.13 2104.27 2079.59
Misalignment 0.999285 0.0183842 -0.0330242
0.0248608 0.999531 -0.0178799
0.00743666 -0.0150361 0.999859

Figure 51: The modeling parameters show values determined in Xsens' calibration procedure

6.2.2.4 Device Settings
In the Device Settings tab, you will find options to set up the MTi’'s communication and it is possible to
change the behaviour of the sensor fusion algorithm in the MTi.

Table 15: The information displayed in the Deveice Settings tab

Parameter Description

COM port baud rate Although the easiest setup with MT Manager is to communicate with
the USB cable that has no baud rate, it is possible to set the baud rate
here. This can be used when you configure the MTi in MT Manager
and later want to use the serial interface on another platform. In order
to reduce waiting times in the usage of MT Manager, the MT Manager
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is designed for high baud rates. Don’t use baud rates of 9600 or 4800
when connecting the MTi to MT Manager.

USB name This string identifies the USB string. Use this string in your application
when you want to communicate directly to the USB-port.

Filter Settings Choose the filter profile that you want to have the orientation estimated
with. When you choose an orientation output in the Output
Configuration window, choose “Onboard: ....” If you are outputting
A only Ag/Av, inertial data or SCR, choose the required setting profile in
“XDA: .....” Refer to [MTi_10s_100s] for more information on the
various filter profiles. Only filter profiles that are applicable for the

attached MTi are shown

Option Flags You can indicate here whether the sensor fusion algorithm should use
additional sensor fusion algorithms. These features are disabled by
default. Refer to [MTi_10s_100s] for more information on these

features.

GNSS Configuration This field allows to choose which constellations must be used. This can
be GPS & BeiDou, or GPS & GLONASS (default). MTi-G-710 and MTi-
7 only.

GNSS Platform This field allows to use a different GNSS setting. Advised to use only

after consultation with Xsens. MTi-7 and MTi-G-710 with FW version
1.7 .x or higher only.

Position This position is the last known position of the MTi, either inputted via a
message (see [LLCP]) or via the GNSS receiver. This data is used to
estimate local magnetic declination and local gravity.

UTC Time With Set current, the current time (in UTC format) is retrieved from the
computer and written into the RAM of the MTi. When recording, the
data will now include the time. Note that the time is discarded after a
rescan, power off or revert.

RotSensor and RotLocal These two rotation matrices are used to apply orientation resets or
arbitrary alignments. Refer to [MTi_10s_100s] for more information on
these two matrices. RotSensor rotates S to S’, RotLocal rotates L to L’
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Output Configuration
Device Settings
Synchronization Options
Modeling Parameters

COM port baudrate
USB name

Filter Settings

Option Hags

Position

UTC Time

115200 -
WPusb#vid_2639&pid_0013#03782083#{fd51225c-700a-47e5-9999-b2d9031b88ed }
XDA: | 39.16 general ~ | Onboard: | 39.15 general - Manage

In-Run Compass Calibration (ICC) - Beta Active Heading Stabilization (AHS)

Latitude [deg] Longitude [deg] Altitude [m]
52.24049169 6.838216771 0

01-Jan-70 12:00 AM Get Set current
RotSensor RotLocal
0 0 1 0 0
1 1] 0 1 0
0 1 0] 0 1
55" R 'L R

Figure 52: Device settings in the MT Settings dialog show various device-specific settings

6.2.2.5 Output Configuration

The output of the MTi can be fully configured in terms of data packets in the data message, output
frequency, and representation format. This can all be done in the Output Configuration tab. There are
two different modes in the output configuration dialog as shown in Figure 53.

Table 16: The modes in the Output Configuration window

Mode

Normal mode

String mode

Description

Mode that supports MTData2 data packets.
Mode that supports ASCII Strings (NMEA).

® | Normal mode String report mode

Figure 53: The mode can be selected with the radio buttons

Normal mode Output Configuration Window

For the MTi 1-series, the MTi 10-series and the MTi 100-series, the most complete Output Configuration
Window is shown in Figure 54. When the MTi is first used, or when it is in factory settings, the Output
Configuration window will be in Normal Mode with the outputs in the default configuration (the default
configuration depends on the product, see [LLCP]). The Output Configuration Window only shows the
outputs available for the connected MTi.
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QOutput Configuration
Device Settings

P - L J
Synchronization Options Normal mode String report mode
Modeling Parameters
Preset: | XDA Processing - Link Formats Link Fregs
Timestamp W/ Packet Counter v/ | Sample Time Fine Sample Time Coarse
UTC Time
Orientation No Orientation - Fioating Point 32-bit 400 Hz
Inertial Data v aq Rate of Turn Floating Point 32-bit ~ | 400 Hz v
v v Acceleration Free Acceleration
Magnetic Field /' Magnetic Field Floating Point 32-bit ~| | 100 Hz -
Temperature Temperature Floating Point 32-bit 400 Hz
Pressure J Barometric Pressure Fioating Point 32-bit v | |50 Hz -
High-Rate Data Acceleration HR Rate of Turn HR 1000 Hz
Status W/ status Word Status Byte
Position and Velocity Latitude and Longitude | No Altitude - Fixed Point 16.32 400 Hz
Velocity GPS Age
‘GNSS Data J Pvt Data Satinfo 4 Hz -

Figure 54: The Output Configuration window of an MTi-G-710 that is attached to MT Manager. When
another device is attached, the output configuration window may contain fewer options.

String report mode Configuration Window

The String report mode Configuration Window allows setting the ASCII strings for MTi 10-series and
MTi 100-series. Note that only a single frequency can be chosen here. Setup the string reports with the
message terminals or via XDA to apply different update frequencies per string output.

Device Settings
Synchronization Options
Modeling Parameters

Normal mode | @ String report mode

HCHDM PRDID

PHTRO HCMTW

PSONCMS HEROT

HEHDT EM1000

NMEA Output 400 Hz ~

TS552 GPGGA

PTCF GPZDA

XSVEL GPRMC

HCHDG

Figure 55: String report mode output configuration options

In order to visualize data in MT Manager, it is required to enable the NMEA parser in XDA. To do this,
first choose the required strings. Note that in order to visualize particular data, that data must be in the
string; there is no possibility to run a filter in XDA. See [LLCP] for details on the various NMEA messages.
Then, right-click on the MTi in the Device List and choose "Enable NMEA protocol”.
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& Xsens MT Manager 2019

Eile View Tools Window Help

FEA%® SR |

®s5 N SFHB ¥
®

Device List

MTI-G-710 07782085

Disconnect

Enable NMEA Protocol

Figure 56: Right-click on the MTi in the Device List and choose "Enable NMEA protocol” to parse data into
binary packets in MT Manager. Configure String report mode first to see this option

Output configuration window in file mode

The output configuration window will be read-only when a file is loaded. It is possible however to view
the settings of the recorded file.

Output Configuration
Device Settings

Synchronization Options U (Ewiei @) ShrpiEreimess
Modeling Parameters
Preset: Link Formats Link Fregs
Timestamp /| Packet Counter «f | sample Tme Fine Sample Time Coarse
% UTC Time
Orientation Euler Angles Floating Point 32-bit 400 Hz
Inertial Data V| Aq Rate of Turn Floating Point 32-bit 400 Hz
V| av Acceleration Free Acceleration
Magnetic Field W/ | Magnetic Field Floating Point 32-bit 100 Hz
Temperature Temperature Floating Point 32-bit 400 Hz
Pressure /| Barometric Pressure Floating Point 32-bit 50 Hz
High-Rate Data Acceleration HR Rate of Turn HR 1000 Hz
Status V| status word Status Byte
Position and Velocity Latitude and Longitude | No Altitude Fixed Point 16.32 400 Hz
Velocity GPS Age
GNSS Data J Pvt Data Satinfo 4 Hz

Figure 57: The Output Configuration Window of a file that contains data from an MTi-G-710. All outputs
are shown, but cannot be edited.

The meaning of all data fields and screens is explained in [MTi_10s_100s] and [LLCP]. A few
functionalities of the Output Configuration window are explained in Table 17.
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Table 17: Buttons in the Output Configuration window

Button/option/functionality Description

@ Normal mode String report mode The radio buttons allow switching between Normal
mode and String Report Mode.

N Processing ol The presets are a safe choice if you_do not know WhICh
Y High-Rate Calibrated Outputs data you need for later re-processing with other filter
Packf Onboard Processing * | profiles, how to retrieve processed data etc. It is highly

T recommended to use these presets. There are three

presets:

- XDA processing

- High-Rate Calibrated Outputs

- Onboard processing
XDA processing offers the most flexibility and is the
recommended setting when you want to reprocess
data later with different settings in XDA. The data of all
sensors has already been processed in the SDI
algorithm, so that the amount of data stored is relatively
low, yet the accuracy is guaranteed.
High-Rate Calibrated Outputs includes
AccelerationHR and RateOfTurnHR, which are
calibrated outputs at frequencies up to 1000 Hz.
Maximum output rate, degree of signal processing, and
calibration applied depends on device and hardware
version. For more information, see [LLCP].
Onboard processing is the desired setting, when you
know what settings you need. All data is calculated
onboard the MTi and does not need further processing.

Starting from a preset, you can tick/untick outputs. In
this case, the preset drop-down menu will become
empty.

Ticking this box will make all formats (Floating point,
Fixed point etc.) the same for each output as long as
these are available. See [MTi_10s_100s] and [LLCP]
for more information on the output formats.

Link Formats

Link Fregs Ticking this box will make all output frequencies the
same for each output if they are available. If a certain
frequency is not available, the output frequency of that
output will be rounded off to the next lower available
output frequency

Frequency of Timestamp and Status Timestamp and Status do not have an output
frequency: they are outputted with every data
message.

Getting ready for logging

Before you start logging your data, be sure to make the following steps first:
1. Set the Log File Name and set the desired working directory, refer to section 6.4.1
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2. Choose the desired output format, refer to section 6.2.2.5. For post-processing purposes, make
sure to use the XDA processing preset. MT Manager will select the required data packages for
post-processing, so it is possible to add more outputs.

3. Setup the desired coordinate system (see section6.2.2.4) on using the Sensor Rotation Matrix
and the Local Rotation Matrix. With the MT Manager, the coordinate system used in the sensors
data cannot be changed during post-processing.

4. Choose the correct baud rate when using serial interfacing. Make sure this baud rate is high
enough to accommodate data sent over the serial interface (total data size and frequency, see
[LLCPY).

5. Choose the setting profile most appropriate for your application. It is possible to process sensors
data with another filter profile, but note that orientation data cannot be reprocessed at all.

Note: The first packet counter is an arbitrary number between 0 and 65535 due to the recording
concept used in MT Manager.
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6.2.2.6 Synchronization options

For detailed explanations of the functions and how to use them, refer to the [LLCP] and
https://base.xsens.com/hc/en-us/articles/211592185-Synchronization-with-the-MTi.

When opening the Synchronization configuration tab in the Device Settings window, the Configured
Settings list is empty for most MTi devices. Press add to start configuration of a synchronization function.

& Device Settings for MT 03782083 ? et

Save Settings | | Wiite to Device

Deviceld 03782083 MT Settings Revision 5.1
Product Code  MTI-300-2A8G4 Frmware Revison ~ 1.7.2 Load Settings Revert
LocationID 0 Sefftest 000001FF
HardwarelD 2704C0A6 Test & Calibration Date 31-Oct-17
Hardware Revision 3.0
Ut LI oy stng
Spctionzation Optons IR Funcion | send Latest () -
Line Inl - Polarity Rising Edge -
Skip Factor 2 - Delay (us) 400 =

400 L?@nd Latest (In)

400 US%

i

Red: voltage on Sync lines

Delete Add

Figure 58: Starting the setup of a synchronization option.
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Function

Trigger Indication
Send Latest

Interval Transition
Measurement

Clock Bias Estimation
GPS Clock Sync

StartSampling

1 PPS

Table 18: List of available synchronization functions

Sync Line'
In 1

In 1

RegData message
SyncOut
ClockSync

GPS Clock In

In 1

SyncOut

Functionality

When a pulse is received, a marker is set in the MTData2
packet

When a pulse or specific (Regbata) message is received,
the latest available data in the MTi is sent to the user.

A pulse is generated at 400 Hz and can be used to trigger
external devices.

Using this function allows you to synchronize the MTi with
an external pulse (0.1 to 1000 Hz).

This (default on) synchronization pulse synchronizes the
clock of the MTi-7 and MTi-G-710 with the GPS clock.

When a pulse is received, samples will be sent to the digital
signal processing pipeline.

1 Pulse Per Second, sent directly from the GNSS receiver
from the MTi-7 and MTi-G-710.

1 Refer to [MTi_1s] and [MTi_10s_100s] to find the hardware lines that correspond to the terms used in the MT Software Suite.

The graphic in the screen will help you determine the behaviour of each function and parameters. The
red line in the graphic shows the voltage received or sent out; the grey arrows or grey lines show the
MTData2 packets. If functions are on separate Sync lines, they can be used together.

Trigger Indication:

The function trigger indication can be used to get a marker inside the MTData2 packet without interfering

with the data itself.
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Function Trigger Indication (In) -
Line Int - Polarity Rising Edge -
Skip Factor | 0 . Delay (us) 0 .

Trigger Indication (In)

. . .

Red: voltage on Sync lines

Figure 59: Trigger Indication sets a marker in the MTData2 packet when a voltage is read on the Syncin
line. The red line represents the voltage on the Sync line

Table 19: Synchronization options of the Trigger Indication function

Parameter Options
Line In 1

Skip factor Applying a Skip factor allows you to omit markers from the MTData2 packet. E.g.
when a Skip Factor of 1 is used, Trigger Indication will omit every second marker.

Polarity Rising Edge, Falling Edge or both: allows you to change the edge on which the
Triggerindication must be included

Delay (us) The number of microseconds before the marker must be included in the data

Send Latest:

Send Latest allows to send the latest available data that has been processed onboard the MTi (it is thus
used as a Syncln). Send Latest ignores the output frequency selected in the Output Configuration
window (but not which outputs are selected) and will prevent data from being outputted until a Send
Latest pulse or RegData message is received. As sampling is done at a very high frequency, it is not
possible to let the sample moment be determined by the Send Latest function. However it is possible to
adjust the frequency of the sampling, use the ClockBiasEstimation function for that. Remember that it is
possible to use functions together if they are on separate Sync lines.

The following parameters can be used:

Table 20: List of options for Send Latest synchronization functionality

Parameter Options

Line In 1 or via a message (RegData)
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Skip factor Applying a Skip factor allows you to discard Syncin pulses. This makes it possible to
have e.g. a 1 Hz input pulse or RegData message, but output MT Data only every 5
seconds.

Polarity Rising Edge, Falling Edge or both: allows you to change the edge on which the Send

Latest command must act. Not applicable to ReqgData.

Delay (us) The number of microseconds before data must be sent. If new data is available after
the reception of Send Latest and the delay together, that new data will be sent.

Function Send Latest (In) -
Line Ini v Polarity Rising Edge -
Skip Factor | 0 s Delay (ps) |0 .

Send Latest (In)

Red: voltage on Sync lines

Figure 60: Send Latest configured as Rising Edge

Interval Transition Measurement: Interval Transition Measurement sends out a pulse on the SyncOut
line at a frequency of 400 Hz (when Skip factor is 0). Interval Transition Measurement can be used to
trigger external devices.
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Function Interval Transition Measurement (Out) -
Line Sync Out  ~ Polarity Rising Edge -
Skip Factor | 0 . Offset (ps) 0

Pulse Width (ps) 1000

‘erval Transition Measurement (O1

Red: voltage on Sync lines

Figure 61: The Interval Transition Measurement with its default settings.

Table 21: List of options for Interval Transition Measurement (SyncOut) functionality

Parameter
Line
Skip factor

Polarity

Offset (us)

Pulse
Width (us)

Options
SyncOut

Applying a Skip factor will reduce the number of sync pulses on the SyncOut line. In the
MTData2 packet, a marker is included that allows you to see which data packet
corresponds to the Interval Transition Measurement pulse. Note that it is recommended
to have a resulting SyncOut frequency that is a integer division of the data output
frequency. E.g. when a SyncOut frequency of 100 Hz is chosen and the data output is
80 Hz, you will miss markers in the data.

The polarity field allows you to choose whether the pulse should be low and will rise upon
a SyncOut pulse (Rising Edge), should be high and will fall upon a SyncOut pulse (Falling
Edge) or should toggle between high and low upon a SyncOut pulse (Rising & Falling
Edge). In the latter case, pulse width does not have an effect.

The offset allows you to send out a pulse before or after the MTData2 package it
corresponds to, is sent to the host. As timing in the MTi is exactly known, it is possible to
send out a pulse up to 3 seconds before the data package.

Pulse Width allows you to determine the duration of the pulse on the SyncOut. If the
pulse width is longer than 2500 ps and no Skip Factor is applied, the pulses will overlap.

Clock Bias estimation: It is possible to slightly adjust the duration of the clock ticks of the internal

sampling in the MTi. This can be useful when you have an accurate external clock (e.g. GPS time pulse,
1 PPS) that you want to synchronize the MTi to. It can also be useful to synchronize multiple MTi’s, so
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that the number of data points in a certain amount of time is equal. For Clock Bias Estimation, it is
needed to know the frequency of the signal you feed into the MTi. Note that you can still choose another
output frequency, unrelated to Clock Bias Estimation.

Table 22: List of options for Clock Bias Estimation synchronization functionality

Parameter  Options
Line Clock In

Skip factor Applying a Skip factor allows you to discard Syncln pulses. Make sure however that the
Clock Period matches the voltage frequency, including Skip Factor. Example: when
applying a 100 Hz voltage signal with a skip factor of 1, the period should be 20 ms.

Polarity Rising Edge, Falling Edge or both: allows you to change the edge on which the Clock Bias
Estimation must calculate.

Delay (ms) The number of milliseconds between pulses. Read Skip Factor (above) if you want to use
Skip Factor as well.

Function Clock Bias Estimation (In) -
Line Clock In - Polarity Rising Edge -
Skip Factor | 0 - Clock Period (ms) |250 | 2 4 Hz

Clock Bias Estimation (In)

Figure 62: Clock bias estimation on a clock of 4 Hz.

Red: voltage on Sync lines

GPS ClockSync:

When the MTi-7 or MTi-G-710 has a valid GNSS fix, the time pulse from the GNSS receiver is used to
synchronize the internal clock of the MTi. The functionality is identical to the (external) Clock Bias
estimation.
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Function Clock Bias Estimation (In) -

Line Clock In - Polarity Rising Edge -

Skip Factor 0 Clock Period (ms) | 250 - 4 Hz

Clock Bias Estimation (In)

Red: voltage on Sync lines
Figure 63: GPS Clock Sync synchronizes the crystal of the MTi and the GPS clock.
The GPS ClockSync function is enabled by default with specific settings; it is possible to disable the
functionality or adapt the settings though. This is not recommended and should only be done when a

more accurate clock is available or when a different clock bias estimation is required. A warning dialog
will pop-up; choosing Yes will re-enable the GPS Sync.

# Warning *
GPS Clock synchronization i1s not enabled correctly. This results in

suboptimal device performance, unless an equivalent or better
external reference clock is used.

Do you want to enable GPS Clock synchronization with the correct
settings?

s

Figure 64: Warning that you are about to delete the GPS clock Sync

StartSampling

StartSampling can be used to accurately time the reception of the MTi data. It is not possible trigger
every sample, but it is possible to start the digital signal processing. Refer to [MTi_10s_100s] for more
info.
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Function | Start Sampling (In) -
Line Int - Polarity Rising Edge -

Deay (us) |0

Start Sampling (In)

Red: voltage on Sync lines
Figure 65: With StartSampling, the MTi will only start sending data when a pulse has been received
1PPS Time-pulse (Out): The MTi-7 and MTi-G-710 can output a hardware pulse (length 100 us) every

second at the exact UTC second.
Function | LPPS Time-pulse (Out) -

Line SyncOut ~

LPPS Time-pulse (Qut)

. Red: voltage.on Sync lines .
Figure 66: 1 PPS Time pulse in the Synchronization dialog

Multiple functions:

It is possible to configure multiple synchronization functions on the MTi. This can be useful if you need
to synchronize multiple devices, see [MTi_10s_100s]. If multiple entries are set on the same line, an
error is given (see below).
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Configured Settings
Warning: These are duplicate settings!
In 1: Start Sampling (In)

In 1: Send Latest (In) Function | Start Sampling (In) -

In 1: Start Sampling (In) ) . - "

In 1: Trigger Indication (In) e [ Polarity  Rising Edge v
Delay (ps) 0 .

Start Sampling (In)

Red: voltage on Sync lines

Figure 67: The Sync Options dialog gives a warning when settings are conflicting or duplicate

Deleting a configured setting:
In order to remove a setting, select the configured setting in the Configured Settings list and click Delete.

6.3 Using the Device/XDA Data View terminals

MT Manager has two message terminals: the Device Data View shows the communication over the
serial or USB port; the XDA Data View shows the communication between MT Manager and the Xsens
Device API. To understand the low level XBus Communication protocol, it is recommended to use the
Device Data View.

6.3.1 Device Data View

The device message terminal allows monitoring the communication over the serial or USB interface of
the MT (i.e. the XBus Communication protocol, see [LLCP]). It can also be used to compose messages
in ASCII; the composer will set the required bits, will include the XBus header (preamble, message ID
etc) and will calculate the correct checksum. The message can then be written to the device.
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Device Data View for MT 07700054 = e |
Compose message
Description PreambleBID MID Len Data Chedﬁum
Compose: GotoConfig >~ FA FF v 30 v 00 D1

Sent to device

0 messages 010000 buffered 0/s ]I Parse MID ["] Parse Data

Received from device

14795 < > Fh FF MIData2 4g 10 20 02 AB EF 10 60 04 05 D& C9 13 20 10 10 3F 79 =«
14794 Fh FF MIData2 4f 10 20 02 AB EE 10 &0 04 05 D8 C8 FA 20 10 10 3F 79
14793 > FA FF MIData2 57 10 20 02 AB ED 10 €0 04 05 D8 C& E1 20 10 10 3F 79
14792 > Fh FF MIData2 4f 10 20 02 AB EC 10 €0 04 05 D8 C8 C8 20 10 10 3F 7%
14791 Fh FF MIDataZ 4§ 10 20 02 AB EB 10 &0 04 05 D8 C8 AF 20 10 10 3F 73
> FA FF MIData2 4f 10 20 02 AB E& 10 &0 04 05 D8 Cg& 86 20 10 10 3F 79
> FA FF MIData2 5 10 20 02 AB ES 10 €0 04 05 D8 C& 7D 20 10 10 3F 79
> Fh FF MIData2 4f 10 20 02 AB E& 10 €0 04 05 D8 C8 &4 20 10 10 3F 73
> FA FF MIData2 4f 10 20 02 AB E7 10 &0 04 05 D8 Cg& 4B 20 10 10 3F 79

27% FA FF MTNara? 48 10 70 0% AR F& 10 &0 Nd NS DR MR 29 20 10 10 2F 748
G

14796 messages 10000 /10000 buffered 419/s [ Parse MID ["] Parse Data

Figure 68: The Device Data View showing data that is being received from the MTi device.

Button/field
GoTo Config

GoTo
Measurement

Send

Compose
message

Table 23: Functions available in the Device Data Viewer

Description

This button can be used to put the MT in Config mode. Config mode is required to
set most messages.

This button can be used to put the MT in Measurement mode. Measurement mode
is the mode in which the MT sends data messages.

The send button is used to send composed messages to the device.

The part “compose message” contains several fields:

- “Compose”: Use this field to find the message you want to send to the
device. You may also start typing in this field; the field has an autofill
function.

- “Preamble”: This is always FA

- “BID”: Bus ldentifier, FF means that the message will be sent to all devices
on the bus.

- “MID”: Message Identifier, this field will be filled out automatically when the
“Compose:” field is filled out. You can also insert a MID here, the correct
“Compose”: message will then be chosen.

- “Len data”: this field indicates the length of the data field. Extended length
appears automatically when data field is longer than 254 bytes.

- “Data”: The data field is used to set arguments for messages. Refer to
[LLCP] for more interpretation.

- “Edit”; Use the edit button to easily set the “Data” field.

- “Checksum”: the checksum is calculated when composing a message
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“‘Message”: the entire message is shown in this field. It is possible to edit
the message here as well.

Sent to | This window shows all messages sent to/received from the device. The sent window
Device includes messages that were generated by e.g. the user interface of MT Manager,
so it is ideal to investigate which communication is used when using the MT
and Manager.
- The number of total messages sent is shown
Received - The number of messages in the buffer is shown. Right-clicking on the
from device window allows you to change the buffer.
- The rate of messages per second is shown.
- A pause button is available to stop the message stream, so you can
investigate and scroll
- When Parse MID is checked, the Message ID is shown in human readable
format.
- When Parse Data is checked, the data is shown in human readable format.

6.3.1.1 Using the message dialogs

The device message terminal has two fields that display the messages sent to the device and received
from the device. Both fields have the same features:

Received from device

20146 <20130213143
20145 <
20144 - 30
20143 <201302

4> FA FF MIDataZ 4f 10 20 02 54 96 10 €0 04 06 3E D5 96 20 10 10 3F 52 =
1> FI FF MTData2 4 10 20 02 54 85 10 &0 04 06 3E DS 7D 20 10 10 3F 52
1> F& FF MTDatal2 57 10 20 02 54 594 10 60 04 06 3E D5 64 20 10 10 3F 52

4365 FA FF MTDataZ 4# 10 20 02 54 93 10 60 04 06 3E D5 4B 20 10 10 3F 52
Flgure 69 A typlcal MTData2 message shown in the Device Data Viewer

Ra PR3 OR

The first column contains a counter, not related to the Data ID “Packet Counter”. The second column
contains the time of the message (yyyymmddhhmmss.sss). The message itself is split into 5 different
parts

- FAFF: Preamble and Bus ID

- MID: default shown in human-readable format, e.g. MTData2

- Length of the data message (in italic)

- Data in the message, default in hexadecimal format

- Checksum (in bold)
Double-clicking on the data message opens a dialog that shows which data is in the message. It shows
the message ID, number of data items (if applicable) and a description of the individual items, both
parsed and in hexadecimal format.
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Received from device

-
ot L ]

MTData2 (MID: 35)

Size: 33 Data: 83 30 12 12 AC CA DO 00 D5 00 BF 00 58 00 91 00 7B 00 67 00 42 10 60 04 00 0E

Number of items:

3

S]

Item 0

YOI XDI (2 bytes) [GpsDop

~ | [Float

MIEE:

Size: Size (1byte) 13

tDOP: UInt16 (2 bytes)

H

TOW: UInt32 (4 bytes) 0

[+ 12accaoo

gDOP: UInt16 {2 bytes) 213

[+] oops

pDOP: UInt16 (2bytes) 191

[2] oosrF

94

[z] oose

vDOP: UInt16 (2 bytes) 145

[2] oost

hDOP: UInt16 (2 bytes) 123

2] oo

nDOP: UInt16 (2 bytes) 103

650> FA
650> FA
527> FA
403> FA
403> FA
334> FA
142> FA
142> FA
024> FA
299> FA
299> FA
236> FA

412 <20130213160101.
411 <20130213160101.
410 <20130213160101.
409 <20130213160101.
408 <20130213160101.
407 <20130213160101.
406 <20130213160101.
405 <20130213160101.
404 <20130213160101.
403 <20130213160100.
402 <20130213160100.
401 <20130213160100.
4 I}

FF
FF
FF
FF
FF
FF
FF
FF
FF
FF
FF
FF

MTDatal
MTDatal
MTDatal
HMTDatal
HMTDatal
MThata
MThata
HMTDhatad
HMTDhatad
HTDhata
HTDhata
MTDhata2l

21
BF
43
21
BF
43
21
BF
43
21
BF
43

%] oos7

Figure 70: Double-clicking the data field will show the items and values
in the data packet

88
88
88
88
88
88
88
88
88
88
88

88 30 12 12 aC 3C 3C 01 B4 01 55 00 A

View Data Field o

B

Copy to Clipboard () Ctrl+C n

Copy to Clipboard (csv) 0

B

Pause el

R a
EsUME

B

Clear A

a

B

Human Readable MID Field
Human Readable Data Field

Max Mumber of Messages 3 =

Figure 71: Right-clicking on the data in the window shows a menu with options

Table 24: The options in the menu in the Device Data Viewer after right-clicking the data.

View Data Field

View Data Field opens the dialog that shows the components of the
data message

Copy to Clipboard

Copies selected messages to .txt or .csv. Use CTRL+A to select all
messages in the window

Pause Pauses the message stream
Resume Resumes the message stream
Clear Clears the buffer and screen
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Human readable MID field | When checked, the hexadecimal message ID’s are parsed to human
readable text. This field is checked when opening the message
terminal

Human readable data field | When checked, the hexadecimal data values are parsed to human
readable text

Max number of messages This setting allows to change the buffer size

6.3.1.2 Composing a message

Using the message terminals to set the MTi is straightforward. Note that you often need to be in Config
Mode to be able to write a message. Then, choose the Message you want to send, using the dropdown
menu.

Device Data View for MT 07700054 ==
Goto Config Compose message
Description PreambleBID MID Len Data Chacksum
Goto Measurement|  compose: STEEGEIY F FA FF + D6 v 05 0200000000 29

SetProcessingFlags -
SetSyncInSettings - None
Sets ettings - Offset 0

SetSyncinsettings - Offset 29491 (0.9%99532 ms)
SetSyncinSettings - Request, Both Edges
SetSyncInSettings - Request, Faling Edge
SetSyncinSettings - Request, Rising Edge [
SetSyncinSettings - Skip factor 0 =
SetSynclnSettings - Skip factor 2

SetSyncinsettings - sampling, Both Edges 2

Sent to device

0 messages 0/10000 buffered 0/s [ Parse MID  [] Parse Data

Received from device

T4618 <2013021 FF MIDataZ 4 10 20 02 95 SE 10 60 04 05 EE FO F3 20 10 10 3F 5C =
T4617 < FF MIDataZ ¢ 10 20 02 95 %D 10 &0 04 05 EE FO DR 20 10 10 3F 5C | |
T4616 < FF MIDataz 57 10 20 02 55 9C 10 60 04 05 EE FO C1 20 10 10 3F 5C
T4615 < FF MIDatal £ 10 20 02 95 9B 10 60 04 05 EE FO A8 20 10 10 3F 5C
T4el4 < FF MIDatal 48 10 20 02 95 92 10 &0 04 05 EE FO 8F 20 10 10 3F 5C
T4613 < FF MIData2 42 10 20 02 385 938 10 &0 04 05 EE FO 76 20 10 10 3F 5C
T4612 < FF MIData2 BE 10 20 02 35 98 10 &0 04 05 EE FO 5D 20 10 10 3F 5C
T4611 < FF MTIDataZ 4g 10 20 02 95 97 10 60 04 05 EE FO 44 20 10 10 3F 5C
T4610 < FF MIDataz 4£ 10 20 02 55 96 10 60 04 05 EE FO 2B 20 10 10 3F 5C

T4AND <7
]

FF MTNa+a? 42 10 2?0 A% @5 45 1A AN N4 N5 ®F FA 12 20 10 10 3F 5

74619 messages 10000 / 10000 buffered 414 /s [ Parse MID  [] Parse Data

Figure 72: Composing a message in the Device Data Viewer can be done by selecting a message from the
"Compose' menu

When you choose a message that starts with “Set” or that needs extra arguments, the text in the button
marked “Edit” will be augmented with an Enter icon ().

Device Data View for MT 07700054 o=

Goto Config Compose message
Description PreambleBID MID  Len Data edit (<)  |thecksum
Goto Measurement|  compoge:  SetSyncnsettings - None * FA FF = D& « 03 000000 2B

Message: FA FF D6 03 00 00 00 28

Figure 73: Click "edit" to make changes to the message selected from the "Compose" menu
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Press Enter or Edit to edit the Data field; you could make changes in the field itself as well.

F = ™
4% Edit Data Field (2 [

[Set/Req]SyncSettings (MID: 2C)
Size: 12 Data: 038020000 00 00 00 00 00 00 00 00

A(r

Number of items: 1]

Item 0

Action: Enum {1 byte) [SendLatest A ] 08
Line: Enum (1 byte) [In1 =] o2
Polarity: UInt8 (1byte) 0 = 00
TriggerOnce: UInts (1byte) 0 = 00
SkipFirst: UInt16 {2 bytes) 0 5 oooo
skipFactor: UInt1s (2 bytes) ¢ | oooo
Delay/Freq: UIntls (2bytes) 0 1 0000
PulseWidth: UInt16 (2 bytes) 0 ]

[ OK ][ Cancel ]

Figure 74: After clicking “edit”, the data field from the message can be edited.

When the data message is composed, the Send button is augmented with an Enter icon (). Press
Enter or the Send button to send the message to the MT. Note that you should receive an Acknowledge
message; visible in the “Received from”-field.

Device Data View for MT 07700054 =0 EER==
Goto Canfig Compose message
Description PreambleBID MID Len Data ChEd(sum

Goto Measurement|  compose: SetsyncSettings = FA FF v 2C ~ 0CJ0000400050000  BS
Send (1) Message: FA FF 2C 0C 08 02 0100 00 00 00 04 00 05 00 00 BS

Sent to device

62> FA FF SetSyncSettings ¢¢ 08 02 01 00 00 00 00 04 00 05 00 00 B5
.162> FA FF GoToConfig [vlv] D1

2 messages 2 /10000 buffered 0/s [ Parse MID || Parse Data

Received from device

FF SyncSettings ¢0

FF GoToConfighck 0o

FF MIDataz2 18 10 20 02 AC 24 20 10 10 3F 47 S5E 16 BD 99 Fe &D
FF MIData2 1g 10 20 02 AC 29 20 10 10 3F 48 33 OC BD 99 31 A5
FF MIData2 1is 10 20 02 AC 28 20 10 10 3F 4A 94 D& BD 97 33 12
FF MTDataZ 1g 10 20 02 AC 27 20 10 10 3F 4F 2D 6B BD 92 EE 44—
FF MTDataZ 1g 10 20 02 AC 26 20 10 10 3F 52 D8 52 BD 8F 98 22
FF MIData2 1l1g 10 20 02 RC 25 20 10 10 3F 55 FE8 22 BD &C ED E9
FF MIDataz2 1 10 20 02 AC 24 20 10 10 3F 58 51 EO BD &7 10 1B
FF MIData2 1A 10 20 02 AC 23 20 10 10 3F &1 3E E4 BD 7F 88 2 7

.

»

m

15 messages 15 /10000 buffered 0/s [ Parse MID || Parse Data

Figure 75: Messages showing the acknowledge sequence in the low-level Xbus protocol
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To verify the settings you just wrote to the device, you can request the settings, in this case the settings

were correctly set:

Device Data View for MT 0770005A

Goto Config Compose message

Description

PreambleBID ~ MID

Goto Measurement|  compose: ReqSyncsettings
Send (<) Message: FA FF 2C 00 D5

Sent to device

Len Da

* FA FF = 2C - 00

eliE ==
ita Che:ksum

D5

FA FF RegSvncSettings 00
FA FF SetSwvnc3ettings 0C
> FA FF GoToConfig (]

08 02 01 00 00 00 00 04 00 05 00 00 B5

D5

D1

3 messages 3 /10000 buffered 0/s

Received from device

1]} Parse MID [ Parse Data

FF SyncSettings 00
FF GoToConfighck G0

[l

FF MIData2 1g 10 20 02 RC
FF MTDataz iz 10 20 02
FF MIData2 1g 10 20 02
FF MTData2 i1z 10 20 02 AC
FF MIData2 1g 10 20 02
FF MIData2 i1g 10 20 02 AC
FF MTData2 iR 10 20 02 AC

20 10 10
20 10 10
20 10 10
10
20 10 10
20 10 10

T T ]
e
[=]
I
=)

(CRC R R SR Y]

20 10 10 3

FF SyncSettings oc 08 02 01 00 00 00 00 04 00 05 00 00 -~

47 S5E
48 33
4n 94
4F 2D
52 D8
55 F8
5B 51

29 F6 60|
99 31 a5
97 33 12
24
8F 98 22
8C BD E9
87 10 1B

»

(LSRN~ =
SR Wm0 m
oo W

opoooDon
w
[
5]
2]

16 messages 16 /10000 buffered 0 /s

1[I} Parse MID [ Parse Data

Figure 76: An example showing how to request settings from the MTi device.

6.3.2 XDA Data View

The XDA Data View is hidden by default. It can be enabled through Tools > Preferences. The XDA Data
View allows monitoring the communication from XDA to MT Manager. Comparing this with the
messages in the device message terminal shows which messages are added or calculated by XDA.
The XDA message terminal can also be used to compose messages in ASCII; the composer will set the
required bits, will include the XBus header (preamble, message ID etc) and will calculate the correct
checksum. The message can then be written to the device.

The dialog for the XDA message terminal is very similar to the dialog of the device message terminal.
Two fields are added: the “Data packets’-field and the “Other messages”-field. The fields “Sent to
device” and “Received from device” are the same as the fields in the device message terminal (see
6.3.1), with the exception that MTData2 messages are excluded from these fields (i.e. only Set-, Reg-
messages and their acknowledge messages are shown).
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XDA Data View for MT 07700054 =N R
Goto Config Compose message
Description PreambleBID MID Len Data Ched@um
Goto Measurement|  compose: GotoConfig ~ FA FF v 30 - 00 D1

Send (&) Message: FAFF 3000 D1

Sent to device Reply from device

0 messages 0 /10000 buffered 0/s  [I Parse MID [T Parse Data 0 messages 0/10000 buffered 0/s [0 [] Parse MID [ Parse Data

Data packets

FF MTData2 28 {(Quaternion|00 0B, 32
FF MIData2 z# {(Quaternion|00 OB, 3
FF MIDataZz 28 {(Quaternion|00 0B, 3
FF MTDataz 28 {(Quaternion|00 0B, 3
FF MIData2 28 {(Quaternion|00 0B, 3
FF MIData2 z# {(Quaternion|00 0B, 3
FF MIDataZz 28 {(Quaternion|00 0B, 32 bvtes, data: 3F E3 07 3C 20 00 00
FF MTDataZ 28 4{(Quaternion|00 OB, 32 bytes, data: 3F E3 07 47 60 00 00
FF MTData2 28 {(Quaternion|00 0B, 32 bytes, data: 3F E3 07 74 00 00 00

bytes, data: 3F E3 06 Cé 20 00 00
bytes, data: 3F E3 06 Dé A0 00 0O
bytes, data: 3F E3 06 EE 80 00 00
bytes, data: 3F E3 07 02 80 00 00
bytes, data: 3F E3 07 06 40 00 00
bytes, data: 3F E3 07 27 00 00 00

3RIRRI R R R RN

cCoooo0o0o0o0oo0

6295 messages 6295 /10000 buffered 101 /s [ Parse MID Parse Data

Other messages (e.qg. errors)

0 messages 0 /10000 buffered 0/s [1 [] Parse MID [] Parse Data

Figure 77: The XDA message terminal has an extra field with respect to the Device Data Viewer, showing
the data received from the Xsens Device API (XDA)

The “Data packets”-field shows the data packets that are generated by the Xsens Device API. These
do nt have to be the same as the data messages that are sent by the MT: when XDA processes e.g.
orientation data based on dq/dv, orientation data is added to the data packets stream (depending on the
selected output configuration).

The “Other messages’- field shows warnings generated by XDA.

Documentation on all functionality can be found in 6.3.1.

6.4 Typical utilisations
This section describes a selection of typical utilisations of the MT Manager.

Note: It is necessary to let the system stabilise right after start-up (filter stabilisation can take up to 60
seconds) in order to get more reliable measurements.

6.4.1 Logging data

Logging data can be started and stopped by pressing the “Record / Stop Record” button (see also
section 5.7.6): o

The generated log file (.MTB file) will be written to the folder specified in the toolbar in the top of the
main window under “Current directory”. By default, this is the root directory of the MT Manager
installation (e.g. C:\Program Files\Xsens\MT Software Suite xxxx.x\MT Manager).

This setting can be changed in the toolbar in the top of the main window under “Current directory”. Make
sure that you have administrator permission for the folder you want to save data in.
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The default log file name can be changed by going to “Tools” = “Preferences...” and selecting

“Logging”:

& Preferences ? X
¥ MT Manager "
Graphs Log Fie Name
Miscellaneous MT_<deviceid>-<trial> .mtb
XDA Options
~ Logging MT_0360005B-003.mtb
Pattern Replacements: %
<date> : Date of Recording (e.g. 2012-09-28)
<deviceid> : Device ID (e.g. 0360005B)
<productcode> : Product Code (e.g.MTi-30-2A5G4)
<time=> : Time of Recording (e.g. 13h12)
<trial> : Trial Number (Sequential) (e.g. 003)

Figure 78: The logging name can be changed in the Preferences window. Use <time> and/or <trial> to
ensure unique file names

6.4.2 Replaying logged data

Playback of logged data can be done by opening an . MTB file that has been previously recorded:
Go to “File” =» “Open File...” (or by pressing “CTRL+0”) and select the . MTE file:

EE)
R " = - v |
@.U.v\ » Computer » Local Disk (C:) » Program Files (x86) » Xsens » * [ 42| [ Search Xsens o
Organize - Include in library + Share with + Burn New folder =~ 0 @'
i Favorites |‘ MName : Date modified Type Size
Bl Desktop B MT SDK 10/24/201213:03 File folder
& Downloads MT Software Suite 41 12/12/201211:02 File folder
4> Dropbox & MT_0360005A-000, mtb 12/12/2012 9:03 MT Binary Logfile 63 KB
i Recent Places # MT_0770005A-002.mth 12/7/2012 7:25 MT Binary Logfile 748 KB
& MT_0770005A-003. mtb 12/10/2012 9:23 MT Binary Logfile 95 KB
4 Libraries
3 Documents -
5 items

Figure 79: Log files of the MT Manager have an .mtb extension

A dialog will be opened that allows you to set the filter profile to process the data with (also exporting).
If you want to process the data with a different filter profile, you have to reopen the file.

# Select Processing Options ? X

No orientation data present in the file.
Please select MT Manager Fitter Processing options.

Fitter profile: 39.16 general -
Active Heading Stabilization (AHS): Enable AHS
In-Run Compass Calibration (ICC): Enable ICC

OK | Cancel

Figure 80: When opening an .mtb that contains SDI data, you choose the desired filter profile
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When you have selected the applicable filter profile, a dialog opens that shows the file loading progress.

Device: 03782083

Filename: J\Desktop\MTM logs\MT_03782083-003.mtb
Orientation: | Available in file: Using XDA profile to generate
XDA Profie: |39.16 general

File Position:  |1759898 / 3259072 (54%)

Reload Stop Cancel

Figure 81: The file loading screen, displaying relevant information on file

Table 25: Parameters shown when data is being processed from a file

Button/field
Device
Filename

Orientation

XDA profile

File position and
Progress

Reload

Stop

Cancel

Description
Shows the DevicelD of the Motion Tracker of which data is being loaded
Full path and file name of the file being loaded

- Not available in file: XDA processes orientation (and position) data with
the filter profile selected.

- Available in file: orientation and position data is not reprocessed, not
even when dg/dv is available in the file. The filter profile is ignored

When XDA (MT Manager) is processing orientation data, this file shows the XDA
profile being used. When orientation data is in the file, this field shows <ignored>

Data is processed from beginning to end. This bar shows the number of bytes
from the file that is already processed. The total file size (in bytes) is shown after
the slash

This button can be used to process the file with a different XDA profile. The
current loading procedure will be cancelled.

Processing the file will be stopped. Already processed data is available in MT
Manager

Loading the file will be cancelled. Data is not available in MT Manager

Logged data can either be presented at once in a graph or played back in real time. These two settings
can be chosen via “Tools” > “Preferences...” > MT Manager > Graphs > File Plotting Method: Real-

time or All Data
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& preferences

¥  MT Manager

orentain s
Miscellaneous
XDA QOptions ® | Euler Angles
¥ Logging
General Quaternion

Temperature Plots

® | Celsius

Fahrenheit

Display Graphs as Strobes

Flle Plotting

Real-Time

All Data (update every 5 seconds unti all data is processed)

® | Al Data (as fast as possible)

Time Options

Minimum Display Time:

Live | 500 ms

File |10 ms

Maximum Display Time

Live | 10000 ms

File | 161000 ms

L)

Default

Default

Default

Default

/| Auto Adjust

OK Cancel

Figure 82: The behaviour of the graphs can be adapted in the Preferences - Graphs window

Time options:

The number of points in the graphs can be chosen in this dialog. When setting the time to a higher value,

the data in the graphs can be investigated over a long period of time.

The “Play” and “Rewind” buttons can then be used to control the playback (see also section 5.7.5):

Ka P

Figure 83: The Playback toolbar

It is recommended to open the desired views before starting the playback.
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6.4.3 Exporting ASCII data

Data previously logged into an .MTB file can be exported to the ASCII format. After opening an

file, click Export @* . The Export Configurations window will open.

& Export Open File

Please configure your export:

Output path

Filename MT_03782083-003-000.txt

Exporter

Filter Profile  XDA: 39.16 general

File Name

ASCII Exporter (*.txt)

Manage

Output Flename:  <inputfie=-<seqnr>

Output Frame

Coordinate Systen ENU

Exported Data

Orientation

Quaternion
«  Euler Angles

Matrix
Inertial Data

Orientation Increment
Velodity Increment

W/ Rate Of Turn
Rate Of Turn (HR)

W/ Acceleration
Acceleration (HR)

Free Acceleration

Delimiter Options

Comma b

Position and Velocity
Position

Velocity

Miscelaneous Sensors

/| Magnetic Field
Temperature
Gyro Temperatures

Barometric Pressure

Here the default file name is defined as:

<inputfile>-<seqnr>-<time>.txt, where

inputfile is the original name of the logged file

seqgnr is incremented each time the corresponding .MTB file is processed.
time is the time read from the system (Windows) clock

67

Figure 84: ASCII exporter settings dialog

.|t
Empty Field Options
NaN -
GNSS Status
GNSS Receiver Message Status Word
Clipping Flags
RSSI
Timestamp
+/  Packet Counter
Sample Time Fine
Date and time
UTC Time
Export Cancel

.MTB
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You can change the output path in this screen (the output path is the same as the “current directory” in
MT Manager). The default export file name is displayed in the Filename field. You can edit this name
before exporting. Press the “Export” button to complete the export. Make sure you have writing rights
for the specified folder.

In the next sub-sections you will find details of the exporter types.

6.4.3.1 ASCII Exporter — File Name
The file name can be configured with the following parameters:

Table 26: Parameters that can be chosen to automatically form a file name for the ASCII exporter

Parameter Description

<date> Data of export (e.g. 2014-09-28)

<deviceid> Device ID (e.g. 0360005B)

<inputfile> Original Filename without extension (e.g. MT0360005B-005)

<seqnr> Sequential number (e.g. 003). Include <seqnr> or <time> to ensure
unique output file names

<productcode> Product code (e.g.MTi-30-2A5G4)

<scenario> Filter profile used (e.g. general)

<time> Time read from the system clock. Include <seqnr> or <time> to ensure

unique output file names

Any text It is possible to add any text, such as dashes, underscores, but also
words and digits in the file name format.

6.4.3.2 ASCII Exporter — Delimiter Options

It is possible to choose the delimiter options that can help you to import the columns of data of the
exported file into an external program. You can also define your own delimiter (one character from the
extended ASCI| table).

Delimiter Options
Other -/

Figure 85: In the delimiter options, you can even choose your own exotic delimiter, e.g. § or V4

6.4.3.3 ASCII Exporter — Empty field options

As the MTi can export data at different output frequencies per data output, it is required to choose the
behaviour when data does not exist in one (exported) data package. You can choose with which
placeholder this field is filled. You can also insert your own string (unlimited). The empty field placeholder
will help you when importing the data into an external program. NaN is commonly used in Excel.

Figure 86: When no data is available in a row, specify your own characters for the empty cell/field
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6.4.3.4 ASCII Exporter — Exported data
The ASCII exporter can export many data quantities. Select those required in the Exported Data section.

Exported Data

Orientation

Quaternion
+/  Euker Angles

Matrix
Inertial Data

Orientation Increment
Velocity Increment

+/ Rate Of Turn
Rate Of Turn (HR)

v/ Acceleration
Acceleration (HR)

Free Acceleration

Position and Velocity
Position

Velocity

Miscellaneous Sensors

v/ | Magnetic Feld
Temperature
Gyro Temperatures

Barometric Pressure

GNSS Status

GNSS Receiver Message Status Word
Clipping Flags

RSSI
Timestamp

/| Packet Counter
Sample Time Fine
Date and time

UTC Time

Figure 87: Options for data export

6.4.3.5 ASCII Exporter — file format
The output consists of a header with settings information and the actual data which is delimited by the

delimiter chosen.

The following picture shows the first part of an example exported ASCII data file in Excel, still as .txt

format:
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A B C D E F G H I J K L M
// General information:
// MT Manager version: 2019.0.0
/! XDA version: 2019.0.0 build 1847 rev 78492 built on 2018-10-11
// Device information:
// Deviceld: 07782085
/! ProductCode: MTi-G-710-2A8G4
// Firmware Version: 1.7.4
// Hardware Version: 3.0.0
// Device settings:
10 // Filter Profile: General(1.17)
11 // Option Flags: Orientation Smoother Disabled, ICC Disabled, AHS Disabled
12 // GNSS Platform: Portable
13 // Coordinate system: ENU

W me N s W =

14 PacketCoulAcc_X Acc_Y Acc_? Gyr_X Gyr_Y Gyr_Z Mag_X Mag_Y Mag_Z Roll Pitch Yaw
15 0 0.227531 0.152013 9.788599 -0.00475 -0.01438 -0.00601 NaN NaN NaN NaN NaN NaN
16 1 0.215365 0.148095 9.796449 -0.00439 -0.01234 -0.00517 NaN NaN NaN NaN NaN NaN
17 | 2 0.188217 0.093649 9.814945 0.003242 -0.00754 -0.0006 0.328625 0.057762  -0.7928 NaN NaN NaN
18 3 0.19495 0.100252 9.805749 -0.00068 -0.00736 0.000715 NaN NaN NaN 0.768004 -1.22792 -89.9999
19 4 0.202981 0.081599 9.803222 -0.00297 -0.00368 -0.00527 NaN NaN NaN 0.767594 -1.22844 -90.0007
20 5 0.196276 0.076297 9.799269 0.002661 -0.0115 0.000954 NaMN NaN NaN 0.767973 -1.23009 -90.0006
21 6 0.216293 0.069534 9.807304 0.001797 -0.00733 -0.00472 0.366533 0.102712 -0.81242 0.768245 -1.23113 -90.0013
22 7 0.216388 0.065471 9.788893 -0.00484 -0.00337 -0.00439 NaN NaN NaN 0.767565 -1.2316 -90.0019
22 o [alelalal=) n ncac n TInATco A AnTAnM n nnca N ANTOT K-kl LYEN Y LYEN Y} n 7c77AC 1 927 4AC Lalalalale]

Figure 88: Exported ASCII txt file in Excel. Empty fields are filled with NaN (configurable in the
Preferences window).

The table below describes the column headers in the ASCII exported file.

Table 27: Overview of all possible exported columns in an ASCII file

Column header # of col. Unit Description
Time and date related data
PacketCounter 1 N/A Packet counter, wraps on 65535

SampleTimeFine 1 N/A Sample Time of the sensor in ticks of 10 kHz (note that data
may come in the file asynchronous; sample times of rows
don’t necessarily have to increase). Sample time fine is a data
packet, and is always exported. This means that if the
recorded file has a higher frequency than the exported file
(e.g. when you are not exporting all data), some rows may
seem to be empty except for the PacketCounter and
SampleTimeFine.

Year 1 N/A Year

Month 1 N/A Month

Day 1 N/A Day

Second 1 s Seconds from the day (midnight starts at 0.00)

UTC_Nano 1 ns Nanosecond of second (UTC format, not necessarily UTC

time)

UTC_Year 1 N/A Year (yyyy) (UTC format, not necessarily UTC time)

UTC_Month 1 N/A Month of the year (UTC format, not necessarily UTC time)

UTC_Day 1 N/A Day of the month (UTC format, not necessarily UTC time)

UTC_Hour 1 hours Hour of the day (UTC format, not necessarily UTC time)
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UTC_Minute 1
UTC_Second 1
UTC_Valid 1

Status data

StatusWord 1
ClippingFlags

RSSI

Sensors data

Acc X/ _YI_Z 3
FreeAcc X/ _ Y/ _Z 3
AccHR_X/_Y/_Z 3
Gyr X/ _Y/I_Z 3
GyrHR_X/ Y/ _Z 3
Mag_X/_Y/_Z 3

Vellnc X/ Y/ Z
Orilnc_q#

Pressure

min
sec
N/A

N/A

m/s?

m/s?

m/s2

rad/s

rad/s

a.u.

m/s

N/A
Pa

Minute of the hour (UTC format, not necessarily UTC time)
Second of the minute (UTC format, not necessarily UTC time)

UTC_Valid is 0 when no GPS is used; otherwise it adopts
UTC_Valid from GPSTimeValidity (see below)

32-bit status, see [LLCP] for information on the Status Word

Received Signal Strength Indicator — used for Awinda to
determine signal strength of MTw wireless communication

3D acceleration, processed via SDI and inverse SDI.

When exported from SCR data, this data is only compensated
for bias, temperature, gain and misalignment (no SDI and
inverse SDI)

3D acceleration, where gravity has been subtracted from.
Maximum frequency is 400 Hz

3D acceleration at rates up to 1000 Hz. See [LLCP] for
meaning of the output per device

3D rate of turn, processed via SDI and inverse SDI.

When exported from SCR data, this data is only compensated
for bias, temperature, gain, misalignment and g-sensitivity (no
SDI and inverse SDI)

3D rate of turn at rates up to 1000 Hz. See [LLCP] for
meaning of the output per device

3D magnetic field, maximum output rate is 100 Hz
When exported from SCR data, data is copied from 100 Hz to
match output frequency

3D delta_velocity (dv); result of SDI algorithm
3D delta_quaternion (dq); result of SDI algorithm

Static pressure (MTi 100-series only)

Orientation, Position and Velocity (data that is processed by the Xsens fusion filter algorithm)

Roll / Pitch / Yaw 3
Quat_q0/q1/9g2/q3 4
Mat[#][#] 9
Latitude / Longitude 2
Altitude 1
Vel X/_Y/_Z 3

deg
N/A
N/A
deg

m/s

Euler angles orientation output
Quaternion orientation output
Rotation Matrix orientation output

Decimal representation of latitude and longitude — estimated
by Xsens fusion filter algorithm — MTi-7 and MTi-G-710 only

Altitude above geoid (WGS84 datum) — estimated by Xsens
fusion filter algorithm — MTi-7 and MTi-G-710 only

3D velocity in same coordinate system as orientation —
estimated by Xsens fusion filter algorithm — MTi-7 and MTi-G-
710 only
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Sensor Component Readout (10-series and 100-series only)

Temperature

GyrTemp_X/_Y/ _Z

SCRAcc_X/_Y/_Z
SCRGyr X/ _Y/_Z
SCRMag_X/_Y/_Z
SCRTemperature

SCRGyrTemp_X/_Y/ Z

1

W =~ W w W

°C

°C

N/A

N/A
N/A
N/A
N/A

Reading of the general temperature sensor, located near the
accelerometers and magnetometer

Reading of the gyroscope temperature sensor, located inside
each individual gyroscope

Digitized (16-bits) analog readout of the accelerometers (bits)
Digitized (16-bits) analog readout of the gyroscopes (bits)
Readout (no bias/gain compensation) of magnetometer (bits)
Readout of the general temperature sensor (bits)

Readout of the temperature sensors in the gyroscopes (bits)

GNSS message (MTi-G-710 only) — composed of 2 distinctive messages that are in exported file in different rows

NUTimeOfWeek
TimeAccuracyEst
GNSS UTC time (GPS)

GNSSTimeValidity

GNSSFixtype

GNSSFixStatusFlags

NumberOfSV
Longitude

Latitude

Height
HeightMeanSealevel
HorizonalAccuracyEst
VerticalAccuracyEst
VelocityN/E/D
GroundSpeed

1
1
7

=W R A A A

ms
ns

Units
according
to column
header

deg
deg
mm
mm
mm
mm
mm/s

mm/s

GPS time of week
Time accuracy estimate

These 7 columns output the UTC time as outputted by the
GNSS  receiver: GNSSNanoSecOfSec,  GNSSYear,
GNSSMonth, GNSSDay, GNSSHour, GNSSMin, GNSSSec
Time is determined by GPS only

Validity flags:

bit (0) = UTC Date is valid

bit (1) = UTC Time of Day is valid

bit (2) = UTC Time of Day has been fully resolved (i.e. no
seconds uncertainty)

GNSS fix type (range 0..5):

0 = No Fix
1 = Dead Reckoning only
2 = 2D-Fix
3 = 3D-Fix

4 = GNSS + dead reckoning combined
5 = Time only fix

Fix Status Flags:
bit (0) = valid fix (within DOP and accuracy masks)
bit (1) = differential corrections are applied
bit (2..4) = reserved (ignore)
bit (5) = heading of vehicle is valid

Number of satellites used in navigation solution
Longitude

Latitude

Height above ellipsoid

Height above mean sea level

Horizontal accuracy estimate

Vertical accuracy estimate

NED velocity

2D ground speed
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MotionHeading 1 deg 2D heading of motion
SpeedAccuracyEst 1 mm/s Speed accuracy estimate
HeadingAccurayEst 1 deg Heading accuracy estimate (both motion and vehicle)
Heading 1 deg 2D heading of vehicle
*DOP 7 - DOP values
ltow 1 ms GPS time of week
Gnssld[#];SvId[#];Cno[#];Flags[#] | 60*4 - Gnssld: GNSS identifier

0=GPS

1=SBAS

2 = Galileo

3 = BeiDou

4 = IMES

5=QZSS

6 = GLONASS

Svld: Satellite identifier

Cno: Carrier to noise ratio (signal strength)

Flags:
bit (0..2) = signal quality indicator
0 = no signal

1 = searching signal

2 = signal acquired

3 = signal detected but unusable

4 = code locked and time synchronized

5, 6, 7 = code & carrier locked; time synchronized
bit (3) = SV is being used for navigation
bit (4..5) = SV health flag

0 = unknown
1 = healthy
2 = unhealthy

bit (6) = differential correction data is available
bit (7) = reserved

Triggers (Trigger1 and Trigger2); MTw only, Trigger Indication of MTi can be found in StatusWord

Trigin1_Polarity 1 N/A Polarity of the signal received:

1: Rising Edge

2: Falling Edge

3: Both
Trigin1_Timestamp 1 N/A The time stamp of the trigger
Trigln1_Framenumber 1 N/A The frame number in which the trigger was received
TrigIn2_Polarity 1 N/A Polarity of the signal received:

1: Rising Edge

2: Falling Edge

3: Both
Trigin2_Timestamp 1 N/A The time stamp of the trigger
TrigIn2_Framenumber 1 N/A The frame number in which the trigger was received
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6.4.4 Exporting KMZ data

It is possible to export data from an MTi-7 or MTi-G-710 to a KMZ file. The KMZ file contains geo-
referenced data points with corresponding orientation, velocity, GNSS mode and times. The contents of
the KMZ file can be customized to match the user’s preferences. The steps to export a KMZ file are:
1. Load an MTi-7 or MTi-G-710 file. This file must contain processed orientation and position,
SCR data (including GNSS PVT data) or data that can be processed with XDA.
2. Set the preferences of the KMZ exporter via Tools-Preferences-Exporters.

a. Choose a Filename template (see 6.4.3.1).

b. Choose the maximum numbers of markers per second. The default value is 1; you
should adapt this value to your velocity: too many data points per second may cloud
the data points in Google Earth.

3. Export the file via File — Export. You can change the output path and file name here.
The file can now be loaded into e.g. Google Earth.

& Google Earth Pro
Ble Edit Yiew Jools Add Help
¥ Search O selssls 9i & (1) [ Rabm

¥ Places

7155 My Places
= /2 Temporary Places
-
b ¢ B paths
v
b ¥ 2 Onentations
» B Tracks
X
Timestamp 289.64
M Posion:  (39.5356354,-122.3394637 , 70.3827999) ftion.at)
Velocty (7.6213372,,-14.7382030, 0.1564780) o ENY
B Orientation:  (-1.1371580, 4.5201608., -63.3135135) deg ot pch.yee)
Gnss mode 03
i Directions: To here - From hers
[ & [i] IR

¥ Layers
* 8 % Primary Database
» [P Borders and Labels
4 B Places
» & 5 photas
¥ BB Roads
» 8 ) 30 Buildings
@ Ocean
£ Weather
# Gallery
8 Global Awareness
More / A
Terrain o Ry .

Figure 89: An MTi-G-710 data point in Google Earth

6.4.5 Using multiple MTis
Multiple Motion Trackers can be managed with the MT Manager.
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Figure 90: Managing an MTi-300 (left) and an MTi-7 (right)
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7 System requirements

The MT Manager is designed for Windows 10 and Linux; the following system setup is recommended
to properly run the software:

e Windows 10 64-bit or Linux 64-bit (no official support for Windows 7/8 or 32-bit platforms)

¢ Intel® Pentium® or AMD® processor, 1 GHz (minimum) Pentium® IV 2.00 GHz or AMD
Athlon® XP 2000+ or higher (recommended)

e USB port (1.1 or higher) or standard PC serial COM-port (RS-232) 45

e Graphics card with 3D hardware acceleration and OpenGL support. Contact your graphics

card manufacturer to ensure your graphics card drivers are up to date. Recommended screen
resolution (height) is 900 pixels or higher.

NOTE: MT Manager is designed to assign a low priority to graphics functions if your computer can not
update the screen smoothly due to insufficient computing resources. This is done on purpose to avoid
interfering with the core functionality of the MT Manager.

4 RS-232 add-on cards are not supported
5 Custom RS-232 USB converters are not supported
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8 Warranty and liability

Xsens Technologies B.V. warrants the products manufactured by it to be free from defects in material
and workmanship for a period of two years from the date of delivery. Products not subjected to misuse
will be repaired, replaced or credit issued at the sole option of Xsens Technologies B.V.

Visit http://www.xsens.com/support for return material authorization (RMA) prior to returning any items
for calibration, repair or exchange. The product must be returned in its original packaging to prevent
damage during shipping.

The warranty shall not apply to products repaired or altered or removed from the original casing by
others than Xsens Technologies B.V. so as, in Xsens Technologies B.V. opinion, to have adversely
affected the product, products subjected to negligence, accidents or damaged by circumstances beyond
Xsens Technologies B.V.’s control.

NOTE: Xsens reserves the right to make changes in its products in order to improve design,
performance, or reliability.

Subject to the conditions and limitations on liability stated herein, Xsens warrants that the Product as so
delivered shall materially conform to Xsens’ then current specifications for the Product, for a period of
one year from the date of delivery. ANY LIABILITY OF XSENS WITH RESPECT TO THE SYSTEM OR
THE PERFORMANCE THEREOF UNDER ANY WARRANTY, NEGLIGENCE, STRICT LIABILITY OR
OTHER THEORY WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPAIR, REPLACEMENT OR, IF
REPLACEMENT IS INADEQUATE AS A REMEDY OR, IN XSENS' OPINION IMPRACTICAL, TO
REFUND THE PRICE PAID FOR THE PRODUCT. XSENS DOES NOT WARRANT, GUARANTEE, OR
MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE
PRODUCT OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY,
OR OTHERWISE. Xsens shall have no liability for delays or failures beyond its reasonable control.
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